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Introduction
Aloha EDC is one of the numerous add-ons in the Aloha suite of restaurant
automation software products, but for operations that depend on credit cards
as a form of payment, it is a critical component of any restaurant automation
system. It was designed to integrate into any of the Aloha hospitality systems
to provide on-line credit card authorization, preauthorization, verification, and
settlement of credit card transactions. In addition, it provides a number of
built-in management tools, such as real-time transaction tracking, maintaining
transaction history files, and customized reporting functions. It was developed
specifically for the hospitality and food service industry, and draws on our
many years of experience and proven performance as the market leader in
Microsoft® Windows® based Point-of-Sale systems for restaurants.

Although Aloha EDC is a powerful restaurant automation and 
management tool, it is simple to install, easy to configure, and 
intuitive to use. Managers will find it an essential add-in to the 
Aloha system.

Aloha EDC (Electronic Draft Capture), works hand-in-hand with the Aloha
system. It is activated and configured in Aloha Manager using check boxes
and text boxes in Maintenance > Store Settings > Credit Card group. These
settings determine how Aloha EDC interacts with order entry terminals in the
Front-of-House, how the magnetic stripe on credit cards is read and inter-
preted, and how the credit card voucher is printed. Additional settings in the
Configure menu in Aloha EDC are used to assign individual card types to spe-
cific credit card processors, configure the modem and dialing procedures, and
store information required for settlement procedures.



vi
The application is launched from an icon in the Aloha program group. It runs as a background
process on the file server, constantly monitoring the Aloha system network and looking for credit
card transaction activity. Preauthorization and authorization requests are processed automatically
with the credit card processor specified for each type of card accepted by the restaurant. Aloha
EDC allows the cashier to exit a guest check before the authorization is complete. The authoriza-
tion process does not lock the terminal so the cashier is able to ring up the next order immedi-
ately. 

One of the unique features of Aloha EDC is that it supports split authorization. This means that
multiple credit cards may be authorized by one processor or by several processors. Completed
transactions are collected into 'batches' that are then 'settled' with the credit card processors at
regular intervals—typically on a daily basis—and credited to the restaurant's account. Settlement
procedures are initiated when Functions > Settle Batch is selected on the Aloha EDC main
screen. Transactions collected into the batch files are sent electronically to the processing com-
pany specified for each type of credit card accepted by the restaurant, then stored in a transaction
batch history file on the Aloha system network file server. There is no limit to the number of
transactions in a batch file, the number of history files, or the length of time they are retained on
the system. 

Another unique feature of Aloha EDC is it supports split settlements. Credit card transactions for
different card types can be kept in separate batches and settled independently. Transactions can
be adjusted or voided by an authorized user before the settlement procedure is initiated. How-
ever, transactions preserved in the history files cannot be edited or deleted in any way after the
batch has been settled. This security feature provides management with an accurate and tamper-
proof record of all transactions sent to card processors.

Setup procedures and problems that are sometimes encountered during setup are covered, in
detail, in Chapter 1 of this manual.
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Concepts and Basic Terminology
What is a batch?

A batch is a group of transactions that are settled together. Usually batches are settled on a daily
basis, but it is entirely possible to have multiple batches per day, or even batches spanning multi-
ple days or weeks.

What is authorization?

Authorization is the process of getting approval from a credit card processor to charge a specified
amount to a person’s credit card. Normally a six-digit approval code is returned. Authorizations
may be declined for many reasons, such as over credit limit or stolen card.

Authorization does not actually result in a charge on a person’s credit card bill, but rather, it does
post temporarily against their credit limit. The charge is not official until the approval code is set-
tled with a final amount (often the final amount is different that the original authorization amount
due to tip adjustments or other edits). If the charge is never settled, the customer is never billed.
The post against their credit limit eventually expires, but it is not clear how long it takes. It may
take up to a month or as little as three days, but there are no published policies.

What is settlement?

Settlement is the process of sending and balancing transactions with the credit card processor.
Charges are not credited to the restaurant or billed to the customer until they are settled. Settle-
ment is sometimes referred to as Data Capture. Settlement should occur within one or two days
of authorization. If a long period of time elapses, it is possible that authorized transactions will be
rejected because the host system decides they have been discarded. (In this event, the transac-
tions must be reentered and reauthorized.)
Aloha EDC User Guide v6.2 Introduction vii
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Processors

For our purposes, a credit card processor is a company that makes money by providing a dial-up
network for authorization and settlement. They also provide various services like reports and bill-
ing for merchants. They are all fairly similar. They act as middlemen, transferring transaction
information to and from some massive backbones managed by EDS and another company, that
do all of the credit cards in the United States. VISA and Mastercard are simply associations of
issuing banks.

What is the difference between host-based and terminal-based 
processors? What is a hybrid processor?

A terminal-based processor is one where the batch is maintained by a terminal at the restaurant.
The terminal (Aloha) keeps track of all authorized transaction amounts. If a transaction is
adjusted (usually to add tips), no dial-out is usually required, because the batch transaction
amount can simply be edited, as long as it is less than the authorization amount. If a transaction is
voided, it is usually just deleted locally from the batch. Credits are simply inserted into the batch,
because they don’t need approval. Whatever is sent during settlement is considered the definitive
amount. As long as the merchant reviews the batch prior to transmission, this method rarely has
problems.

A host-based processor is designed primarily for more primitive systems, which cannot maintain
and edit the batch at the restaurant. Instead it is kept at the host processor. Therefore, any change
to the batch requires a dial-out to the processor to authorize, adjust, void, or credit. Host-based
processing is really more retail-oriented than restaurant-oriented, because retail transactions are
simpler and aren’t usually adjusted for things like tips. If someone is out of balance between the
restaurant and the host system, it is hard to track down because typically you have to call the pro-
cessor and review the batch. Many processors support both terminal and host-based processing,
in which case the Aloha system only supports the terminal-based processing.

Some more recent processors, such as Nova, have adopted a 'hybrid' processing scheme. This is
similar to host-based processing because most transaction activity requires a dial-out. However,
it is somewhat more flexible because the restaurant system has the ability to upload the complete
batch during settlement if there is any balancing issue.
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Is a host-based or terminal-based processor preferable?

Terminal-based processors are definitely preferable because the Aloha system does not have to
dial out for adjustments and voids, and there is less potential for problems due to the fact that the
processing is simpler. In addition, if a batch cannot settle, it is possible to manually set the batch
aside and return to processing a new batch while Technical Services works on the problem batch.
With host-based or hybrid systems, you cannot start a new batch until the current one is settled or
cleared.

Why would someone use multiple credit card processors?

Cost and time savings are the benefits to using multiple processors. The most common example
is authorizing and settling through AMEX directly, and using another processor such as Visanet
or CES for all transactions other than AMEX. Rates are lower for processing through Visanet or
CES; however, merchants receive their money faster from AMEX if those transactions are not
routed through another processor.

What is the directory structure?

Normally, the primary EDC directory resides in the EDC subdirectory under <Iberdir> on the
BOH file server, e.g. C:\Aloha\EDC. This directory can be overridden with the EDCPath envi-
ronment variable; however, the EDCPath variable is only needed for SuperSites. Under the EDC
directory, each processor has its own subdirectory. For example: \EDC\Amex or \EDC\Visanet.

Here is a description of the files found in the EDC directory: 

File Description
EDC\Edc.ini EDC Configuration File

EDC\*req Request files from FOH

EDC\*.hld FOH requests currently being processed

EDC\*.ans Completed requests

EDC\Changed Marker file indicating to the FOH that at least one file 
has changed

EDC\ProcessorName\Txn* Txn files making up the current batch for the proces-
sor

EDC\ProcessorName\Settling Marker file indicating that settlement is currently in 
progress for the processor.
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Where is EDC configuration information stored?

All configuration information for EDC is stored in Edc.ini, which is located in the main EDC
directory on the file server.

Anatomy of a TXN File

Manually editing or otherwise manipulating .txn files is highly discouraged. However, when
troubleshooting, it is useful and important to understand how they work. 

The following fields are currently in .txn files: 

EDC\ProcessorName\Settled Marker file indicating that settlement has been com-
pleted for the processor

EDC\ProcessorName\YYYYMMDD.stl Settlement file containing all of the txn* files for a set-
tled batch.

File Description
TYPE Type of action: (Authorize, Preauthorize, Adjust, Void, Credit, Force, 

Settle, ForceSettle)

DOB Date of business

DATE System date

TIME System time

TERMINAL Originating terminal, or BOH

MANAGER If manager approval was required, who did it

EMPLOYEE FOH Employee preforming the action

TABLE Name of table or QuickService order

CHECK Check number

PAYMENT Unique payment ID

AUTHAMT Amount to authorize

BATCHAMT Amount to settle

BATCHTIP Tip amount to settle

File Description
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The following fields are used for SuperSite installations only: 

PROCESSOR Which credit card processor handles this transaction.

CARDTYPE Type of card (VISA, MC, etc.)

CARD Card number, masked

EXP Expiration (MMYY)

TRACK1 Track 1 magnetic card information, if available (encrypted)

TRACK2 Track 2 magnetic card information, if available (encrypted)

REF Reference ID that identifies the batch transaction this action is updating. 
A transaction consists of all the txn files that have the same Ref ID.

APPROVED YES, if the action succeeded, NOT if failed for any reason.

AUTH Authorization code for successful authorizations

ERROR Error text for failed actions

INFO Additional internal transaction information 

REASON For void actions, the explanation for the void

NOCAPTURE Indicates that the authorization succeeded but the transaction is not 
allowed.

PROCNO Processor number of settlement processor

FILENO Number of the txn file

STANDALONE Yes if the action occurred while the FOH was in fake authorization 
mode. Standalone transactions appear on the batch report with a ‘*’.

File Description
PINDEX Processor index. Distinguishes the batch the transaction goes into 

when you have multiple simultaneous batches for a processor. Note: 
This setting comes from Terminal Maintenance in the EdcInfo field.

TERMID Terminal ID. This does not necessarily correspond to the Aloha terminal 
number. This is a specific terminal ID to be sent to the processor so that 
they can report on credit card activity by terminal. Note: This setting 
comes from Terminal Maintenance in the EdcInfo field.

File Description
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The following fields are used for check authorization only (Currently supported for Nova BOH
Processor only): 

Additional fields appear in txn files if the Aloha system is interfaced to a Property Management
System (PMS). See Interfacing PMS with Aloha User Guide for further information.

What is the relationship between transaction numbers and Txn file 
numbers?

There is no relationship at all. Many people have discovered the hard way that if a batch settle-
ment is failing on transaction 39, that Txn00039 has nothing to do with it. Batch transaction num-
bers are shown in the Select Transaction dialog box when you adjust or void transactions from
the BOH. That is currently the only way of determining the transaction number.

What happens during the settlement process?

The following steps occur during settlement:

• EDC creates a Settling file in the directory of the processor being settled.
• EDC dials out to the processor and sends detailed information about all of the transac-

tions in the batch. The processor may approve or reject the batch.
• EDC deletes the Settling file.
• The txn file for the settlement transaction is written out.
• If settlement failed, nothing else happens.
• If settlement succeeded, Aloha EDC attempts to archive the current batch.
• A settlement file is created that contains a header with some batch information and the 

text of all .txn files in the batch. The name of the settlement file is typically YYYYM-
MDD.stl, where YYYYMMDD is the current date. If a settlement file already exists with 
that name, the settlement file is named YYYYMMDD.A, YYYYMMDD.B, and so on.

File Description
MICR Magnetic Ink Character Recognition code along bottom of check

DLL Drivers license

CHECKNO Check number

STATE State

ZIP Zip code
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• If the settlement file is successfully created, the .txn files are deleted.
• A Settled marker file is created.
• If the archive batch process fails, it is a serious problem. Aloha EDC displays the follow-

ing message five times: 'Settlement succeeded, but error nn occurred. Contact Technical 
Support and Write Down the Settlement authorization (Error message x of 5).' The rea-
son this is serious is that the batch was settled, but was not cleared out for some reason. 
This raises the risk of settling the same batch twice and double-billing customers.
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Downgrades
Downgrades are transactions that are charged at a higher rate than the preferred rate. Merchants
become very unhappy when downgrades occur regularly. For a transaction to receive the pre-
ferred rate, the following must occur:

• The magnetic stripe from the card must be read. Manually keyed card numbers are 
downgraded because they present a higher risk of fraud.

• The transaction must be settled for an amount, which is not more than 20% over the orig-
inal authorization amount, and not less than 20% below the original authorization 
amount.

Tip adjustments never dial out for additional authorization, no matter how large the tip. Tip
authorization percentage is configurable, and defaults to 20%. This setting is in Aloha.ini as
EDCAuthTipPercent and can be set from Aloha Manager under Maintenance > Store Settings >
Credit Card Group. (Note: In Aloha.ini, 20% is represented as .20, not 20. In Aloha Manager,
20% is entered as 20, with no decimal point. This means that if a customer has a $10 order, the
credit will be authorized for $12. As long as the settlement amount is between $9.60 (80% of
$12) and $14.40 (120% of $12), the transaction is not downgraded. This is normally the case. If
the customer leaves more than a 44% tip, it is downgraded. Establishments that have a lot of very
large tips might consider raising the default tip percent for authorization to more than the default
of 20%.
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How This Guide is Organized
This guide is designed to help you familiarize yourself quickly with the Aloha EDC. It is orga-
nized as follows:

Chapter 1: Configuring Aloha EDC

This chapter discusses the preparatory requirements for the Aloha EDC software. This includes
the steps required to interface with the Aloha system, as well as instructions to set up the
modem(s), processor(s), credit cards, and more.

Chapter 2: Using Aloha EDC

This chapter discusses the available menu commands and their functionality within Aloha EDC,
as well as how Aloha EDC works in relation to the Aloha system.

Chapter 3: Troubleshooting EDC

This chapter discusses tips for optimizing your use of the Aloha EDC program, processor errors,
and installation guidelines.

Index
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Conventions Used in This Guide
Numerous graphics and instructions appear throughout this guide. These conventions make it
easy to find and understand information. 

Symbols and Alerts

The following graphic symbols alert you to important points throughout this guide: 

Highlights a special point of interest about the topic under discussion.

Alerts you that the operation being described can cause problems if you are 
not careful.

Directs you to a more complete discussion in another chapter of the current 
guide, or other reference material.

Points to a useful hint that may save you time or trouble.
Introduction Aloha EDC User Guide v6.2



Chapter
1

Configuring Aloha 
EDC
This chapter discusses the preparatory requirements for the Aloha
EDC software. This includes the steps required to interface with the
Aloha system, as well as instructions to set up the modem(s), proces-
sor(s), credit cards, and more.

Installing Aloha EDC......................................................................... 1-4
Client/Server Remote Access........................................................ 1-7
Installing EDC Outside of Bootdrv Share....................................... 1-7
EDC and Redundancy ................................................................... 1-9
Environment Variables that Affect EDC ...................................... 1-10
Command Line Options that Affect EDC .................................... 1-11

Interfacing EDC with the Aloha System.......................................... 1-12
Activating and Configuring the EDC Setup Tab........................... 1-12
Defining Requirements for Pre-Authorization .............................. 1-16
Customizing the Voucher............................................................. 1-17
Creating Card Tenders ................................................................ 1-23

Configuring Aloha EDC................................................................... 1-34
Stopping POS Processing ........................................................... 1-34
Configuring Store Information...................................................... 1-35
Configuring Modems.................................................................... 1-36
Configuring Gateways ................................................................. 1-40
Configuring Processors ............................................................... 1-44
Configuring Private Label Cards.................................................. 1-76
Assigning Cards to Processors.................................................... 1-77
Defining Additional EDC Options................................................. 1-78
Starting POS Processing ............................................................. 1-79

Defining an EDC Processing Path.................................................. 1-80
Editing EDC.ini................................................................................ 1-81



1 – 2 Configuring Alo
ha EDC Aloha EDC User Guide v6.2



C
onfiguring

A
loha ED

C

Before you can use Aloha EDC to process Aloha EDC transactions, you must define several
items. This chapter discusses the setup requirements for Aloha EDC, in detail. You establish the
interface between Aloha EDC and the Aloha system using the Store Settings and Tenders func-
tions within either Aloha Manager TableService or Aloha Manager QuickService. Define other
requirements include defining store information, modems, credit card processors, etc, using the
Configure menu within Aloha EDC.

In this chapter you learn how to:

• Enable Aloha EDC and define EDC settings such as whether to use mock authorizations 
when the EDC file server is down, the maximum mock authorization amount, the tip per-
cent to use for authorizations, the masking option to use, etc. These changes do not reflect 
in the FOH until Refresh Data is processed. Refer to the Refresh Data section in this 
chapter for information on this procedure.

• Customize voucher text and print options.
• Configure stores and modems.
• Configure credit card processors to enable authorization of multiple transactions during a 

single dial-up connection. 
• Establish dialing properties for each credit card processor. This includes authorization 

and settlement phone numbers, as well as the modem authorization and initialization 
strings. 

• Assign the credit cards accepted by the restaurant to the proper credit card processor. 
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Installing Aloha EDC
Aloha EDC is a 32-bit application that is designed to run under Microsoft Server 2003®. Aloha
EDC does not run in Windows 3.1 or Windows for Workgroups. Aloha EDC also requires DCom
(Distributed Component Object Model). DCom comes standard with Windows NT 4.0 and
above, but DCom 1.1 must be installed separately on Windows 95. Windows 95 may also require
the Atl.dll file, which is located in the DCom95 subdirectory and is for Windows 95 only. Do not
use this file for Windows NT. 

Aloha EDC is distributed on the Aloha Installation CD, which contains all files necessary to
install, configure and run the application. Before installing Aloha EDC, verify the following
hardware and software requirements:

• A computer, typically the back office computer, designated as the Aloha system network 
file server running a compatible operating system, preferably Windows 2003. 

• Either Aloha TableService or Aloha QuickService, v4.2 or higher.
• An internal or external modem from the list of supported modems. Refer to the 

ReadMe.txt file on the distribution disk for an up-to-date list of the supported modems. 
You should install and verify the modem is working before you perform these instruc-
tions and note the correct COM port. Refer to the user manual supplied with the modem 
for installation and testing procedures.

• For dialup connections, use a dedicated telephone line with an RJ11 jack. The telephone 
line should not be used for any purpose other than Aloha EDC, and you must disable any 
optional service features, such as Call Waiting or Call Forwarding. This is for minimum 
requirements. It is preferable to use a cable/DSL connection for a high speed connection.

• Completed Configuration Profiles of the credit card processors that are used by the res-
taurant. Refer to the worksheet for your specific processor.

• The Aloha Installation CD.

The EDC Installation program sets up EDC as a service, but it always helps to know what is hap-
pening behind the scenes. The following steps outline the procedures if you were to manually
install Aloha EDC.
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EDC now requires three Aloha files: EDCUI.exe, EDCSvr.exe, and EDCSvrPS.dll. It also
requires DCOM (Distributed Component Object Model). DCOM comes standard with Windows
NT 4.0 (and subsequent releases), but you must install DCOM 1.1 separately on Windows 95.
The required Windows 95 DCOM files are self-extracting, and are included in the DCOM95 sub-
directory as DCOM95.exe and DCM95Cfg.exe. Windows 95 may also require ATL.dll. The file
ATL.dll is also in the DCOM95 subdirectory and is for Windows 95 only. Windows NT comes
with its own version of this file, and it is installed by default on Windows NT machines (do not
overwrite it).

There are two potentially different installation processes:

Client and server — This is the most common scenario. A standard Aloha restaurant
runs EDC service and the UI both on the BOH.

Client only — This is used to set up a remote workstation that has access to the EDC
user interface, but actual processing only occurs on the server to which it connects.

For Windows NT 4.0:

1. Copy the three EDC files into the \Bin directory.
2. From the command line, go to the \Bin directory.
3. For Client and Server, register the service with the command ‘EDCSvr /Service.’ There is 

no message after this command. Go to Control Panel/Services and verify that EDC is 
now listed in the list of services. You can stop and start the service from there, as well as 
specify Automatic startup.

4. For Client only, register the service with the command ‘EDCSvr /RegServer.’ There is no 
message after this command.

5. Type the command ‘RegSvr32 EDCSvrps.dll’ to register the EDCSvrps.dll. If successful, 
you receive a message stating, ‘DllRegisterServer in EDCSvrps.dll succeeded.’

6. Run the program DCOMCnfg.exe and make sure ‘Enable DCOM on this computer’ is 
selected.

7. For Client only, run DCOMCnfg.exe and select EDC in the list of servers. Click Proper-
ties, then click the Location tab. Clear ‘Run application on this computer.’ Select ‘Run 
application on the following computer’ and select the computer where the server is 
installed. Note that you can type either a computer name or a raw IP address in the field.

8. From the command line or Explorer, run the user interface with EDCUI.
9. If you need to uninstall the service, type EDCSvr /UnRegServer from the command line. 

Be sure to stop the service, also (under Control Panel > Services > Select EdcSvr and 
click Stop.)
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For Windows 95:

1. Install the DCOM95.exe and DCM95Cfg.exe self-extracting files.
2. Copy the three EDC files, and ATL.dll for Windows 95 into the \BIN directory.
3. From the command line, go to the \Bin directory.
4. Type the command ‘RegSvr32 ATL.dll.’ If successful you should receive a message stat-

ing ‘DLLRegisterServer in ATL.dll succeeded.’ (Note: This step may not be required.)
5. For Client and Server, register the service with the command ‘EDCSvr /Service.’ Win-

dows 95 does not support services directly, but supports the concept of ‘pseudo-services’ 
which are non-interactive programs that start at startup. You can check this in RegEdt32 
under \\HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVer-
sion\RunServices, where any key value may be set to the full path of an executable to be 
run as a pseudo-service.

6. For Client only, register the service with ‘EDCSvr /RegServer.’ There is no message 
after this command.

7. Type the command ‘RegSvr32 EDCSvrps.dll’ to register the EDCSvrps.dll. If successful 
you should receive a message stating ‘DLLRegisterServer in EDCSvrps.dll succeeded.’

8. Run DCOMCnfg.exe and make sure you now see ‘EDC Class’ listed in the list of serv-
ers. Under the Default Properties tab make sure ‘Enable Distributed COM on this com-
puter’ and ‘Enable remote connections’ are selected. (Note: Allow remote connections is 
only in the Windows 95 version of DCOMCnfg.exe)

9. For Client only, run DCOMCnfg.exe and select EDC in the list of servers. Click Proper-
ties, then click the Location tab. Clear ‘Run application on this computer.’ Select ‘Run 
application on the following computer’ and select the computer where the server is 
installed. Note that you can type either a computer name or a raw IP address in the field.

10. From the command line or Explorer, run the user interface with ‘EDCUI.’
11. If you need to uninstall the service, type ‘EDCSvr /UnregServer’ from the command 

line. You will also need to reboot, since the service will still be running.

For client only machines, the EDCSvr.exe program is not used except during DCOM configura-
tion. If you have installed EDCSvr with /Service, you should not try to run EDCSvr.exe directly.
This causes it to show up in the task list, and can cause some unpleasant problems. For Windows
NT, you can specify a user account under which to run the EDC service in Control Panel > Ser-
vices > Startup. The default is the system account; however, it can sometimes be useful to set up
a privileged user account for the service, if the service requires access to protected network
resources.
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Although NetBIOS alone is sufficient for client/server to work on the same machine, TCP/IP is
required for client only connections to work. This means the TCP/IP protocol must be installed,
and some form of WINS, DNS, or DHCP must be functioning properly to resolve names from IP
addresses. If you cannot get remote connections to work, use ping and nslookup command line
utilities for troubleshooting TCP/IP connections. If you cannot ping the remote machine, then you
cannot get a DCOM connection to it. If you cannot resolve the host name with nslookup, then
DCOM will not resolve the host name to an IP address either.

Client/Server Remote Access

With version 4.2 (and subsequent versions), EDC processing has become a ‘service.’ A service is
a program that runs in the background and does not have a user interface. Services can run as
soon as Windows starts, and do not require a user to be logged in, as in other programs. The user
interface for EDC is now a separate program. 

This architecture has several advantages over earlier methods:

• EDC processing no longer requires someone to be logged in to the server at all times. 
This increases security, especially under Windows NT.

• The Aloha EDC user interface can run from any machine, not just the server. In addition, 
more than one person can access it at one time. This makes it possible to ‘lock the server 
in a closet,’ which is often requested by customers with large mission-critical installa-
tions. It also makes it more convenient to access EDC information from other desktops.

EDC does not have to run as a service. You can run EDCSvr.exe as a standalone program,
although it still must be registered by running EDCSvr.exe/RegServer.

Installing EDC Outside of Bootdrv Share

This requirement stresses the need to prevent the insecure storage of cardholder data. When the
system does store cardholder data, even if momentarily, the system should encrypt the informa-
tion to render it unreadable. Configure the Aloha system to disable any audit processes that may
result in the storage of full credit card numbers, or other information obtained from the magnetic
stripe. Mask cardholder data and card numbers, whenever possible.

We recommend you use Aloha v6.1 or above, as these versions take advantage of 128-bit encryp-
tion, required by these standards, for the brief periods of time when cardholder data may be stored
on disk. The Aloha system encrypts cardholder data any time it is at rest, and purges non-essential
data, such as track data, after completing the authorization process.
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Also with Aloha v6.1, Aloha EDC is capable of storing data files related to credit card processing
outside the established ‘Iberdir’ path, by using a new environment variable, EDCProcPath. This
change affords more data security and customer protection by moving non-temporary files
related to transaction authorizations and settlements outside the ‘Bootdrv’ share currently used
by the Aloha system. Data not stored within the shared file structure is much less likely to be
available to anyone entering the system from an external location. You can configure Windows
and the Aloha system together to permit only the system administrator access to these files. 

To move non-temporary EDC files outside the Iberdir file structure:

1. Settle all pending batches, prior to continuing with this procedure.
2. On the EDC server (typically the Aloha BOH file server), create a new path for EDC 

outside the \Bootdrv file structure. For example, if the current file structure is C:\Boot-
drv\Aloha\EDC, you could use C:\AlohaEDC\EDC.

3. Log in to Aloha EDC and select File > Stop POS Processing.
4. Log out, and close Aloha EDC, and close any remote instances of EDC running on other 

computers on the network, such as a manager workstation.
5. Stop the EDCSvr Windows service.
6. Create a new environment variable, EDCProcPath, specifying the new location for the 

EDC folder created above.
7. Move the contents of the old EDC folder to the new location.
8. Start the EDCSvr Windows service.
9. Open and log in to Aloha EDC.
10. Select File > Start POS Processing. 

When you configure the system in this manner, the system (Aloha FOH, BOH, or Aloha EDC)
writes all authorization request files (.req) to the default EDCPath, and the transaction (.txn) and
settlement (.stl) files to the new EDCProcPath location. The system writes answer (.ans) files to
the EDCPath location. The FOH deletes .ans files from EDCPath after processing the response,
so the file remains in the shared path for only a short time. The system writes .stl and .txn files
solely to the EDCProcPath location. EDCSvr reads the EDC.ini and other EDC files in the
EDCProcPath location, and monitors the current EDCPath location for incoming .req files. 

The Aloha system assumes %Iberdir%\EDC as the default location for the environment 
variable, EDCPath. It is not necessary to create this variable, as Aloha assumes this 
location if you do not. If you want to use a path different from the default for EDCPath, 
create the new folder, and create a new environment variable, EDCPath, to match the 
new location. The EDCPath folder must be within the \Bootdrv location.
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EDC and Redundancy

There are two ways of approaching EDC and redundancy:

1. Attempt to maintain live transaction authorization despite server failure.
2. Simulate live transaction authorization during server failure.

Redundant Dialout

In a typical restaurant, there is only one modem on the BOH computer that is used for EDC dia-
lout. If this is the case and the BOH goes down, you have lost EDC dialout capability. On the
other hand, if you put a modem in the master terminal, and you run EDC on the master terminal
as well as on the BOH, you can have a fairly effective redundant EDC. Anytime the master termi-
nal takes over as the file server, .req files begin to be spooled to the \EDC directory on the master
terminal. If EDC is running on the master, it picks up those files and processes them. The only
problem with this approach is that EDC currently does not ‘mirror’ the .txn files from the BOH
on the terminals. Because of this, any transactions started before the file server went down will
not be in the batch on the master terminal; therefore they cannot be adjusted or voided until the
BOH recovers. New transactions rung after the BOH failure works normally. In this scenario, you
must remember that there are two batches, one on the BOH and one on the master terminal. Each
batch must be settled.

Simulated Authorization

Few restaurants install redundant modems, so a software-based approach is useful also. Aloha
also supports a ‘fake’ authorization mode that allows FOH terminals to automatically authorize
transactions when the BOH is down.

To enable this functionality, the EDCSpoolDown variable in Aloha.ini must be True. The maxi-
mum amount of a fake authorization is set by EDCFloordown in Aloha.ini. You can access these
settings in Maintenance > Store Settings > Credit Card group.

When EDC generates fake authorizations, they are spooled in the \EDC directory on the master
terminal as .spl files. The master terminal debout indicates any ‘fake’ activity that occurs. The
Aloha EDC program on the BOH server periodically scans the terminals and picks up these
spooled transactions. This scanning is usually invisible, but the /DebugScan option on EDC will
cause the Aloha EDC program to output detailed information into the Debout.edc file showing
the scanning activity. When Aloha EDC picks up spooled transactions, it performs a real authori-
zation at that point. Typically, the authorization succeeds, and the transaction is added to the cur-
rent batch and is settled normally. ‘Fake transactions’ that successfully authorize print on the
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Aloha EDC batch report with ‘*’ next to them. If the authorization fails, the merchant is in jeop-
ardy of losing money because the FOH allowed the sale to occur. Therefore, failed authorizations
that were spooled using fake authorizations are selected at the bottom of the Aloha EDC batch
report. The merchant should review these carefully, if they occur, to avoid losing revenue.

The /ScanRestrict FileName option on EDC will cause the scan to only pay attention to transac-
tions from terminals where the \EDC directory contains FileName. This is useful in SuperSites if
you are running more than one copy of EDC and you want each copy of EDC to pick up transac-
tions from only a particular set of terminals.

The ‘fake authorization’ mode is only activated when the BOH is down and the master terminal 
cannot open an .req file on the BOH server. If the BOH is up, fake authorizations do not occur, 
even if the Aloha EDC program is turned off and is not processing requests. This functionality is 
intended to handle hardware, not software, failures. 

You can use the following environment variables and command lines to optimize your EDC
setup.

Environment Variables that Affect EDC 
Environment 
Variable Default Description
Iberdir C:\Aloha or 

C:\AlohaQS
Root Aloha directory. Must be set for the current Aloha ver-
sion for client/server remote access.

Datadir Data Subdirectory of <iberdir> containing FOH configuration files.

EDCDir EDC Subdirectory of <iberdir> containing EDC files.

EDCPath C:\Aloha\EDC 
or C:\Alo-
haqs\EDC

Full path of directory containing EDC files.

PMSDir PMS Subdirectory of <iberdir> containing PMS files.

PMSPath C:\Aloha\PMS 
or C:\Alo-
haqs\PMS

Full path of directory containing PMS Files.
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Command Line Options that Affect EDC 
Command Line 
Option Description
/NoMutex Do not enforce mutual exclusion. This means you can run more than one 

copy of EDC at a time. Not usually recommended. Can be very hazard-
ous.

/Iberdir xxx Overrides the Iberdir environment variable.

/DataDir xxx Overrides the DataDir environment variable.

/EDCDir xxx Overrides the EDCDir environment variable.

/EDCPath xxx Overrides the EDCPath environment variable.

/PMSDir xxx Overrides the PMSDir environment variable.

/PMSPath xxx Overrides the PMSPath environment variable.

/DEBugExt xxx Changes the extension of the Debout file The default is EDC. When you 
have multiple copies of EDC running, this option lets you specify different 
extensions for their debugging output files.

/Title xxx Specifies text to display in the title of the EDC program window. Also use-
ful when running multiple copies of EDC.

/ReportMode Runs in a mode that only allows the user to run batch reports. Sometimes 
useful for setting up extra copies of EDC on remote stations that do not 
interfere with regular EDC operation. /Iberdir is typically required if you are 
using /ReportMode on a remote machine, so that EDC can find the 
EDC.ini file and related security key information.

/ScanRestrict xxx Specifies that EDC is to scan for standalone transactions (.spl files) only 
on FOH terminals that have an .xxx file in their EDC directory. Useful when 
running multiple copies of EDC in SuperSites.

/DebugScan Outputs detailed debugging information when scanning for .spl files on 
FOH terminals. Not recommended for normal operation because of the 
large volume of debugging, but can be useful in helping you understand 
how EDC and redundancy work together.
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Interfacing EDC with the Aloha System
Use the Credit Card group in Aloha Manager to activate EDC, and set up the interface between
Aloha EDC and the Aloha system. You must also use the Tenders function in Aloha Manager to
define credit card types and to set required authorization and identification. You must be logged
in to Aloha Manager to configure these options. 

Activating and Configuring the EDC Setup Tab

Use the EDC Setup tab on the Credit Card group to activate the EDC program, enable mock
authorizations, and establish the method to use for credit card masking.  

The following procedure includes the required or suggested settings for setting up the EDC Setup
tab. Other settings on this tab, although available, are not discussed.

Refer to the Aloha QuickService or TableService Reference Guides for more informa-
tion on options on the Credit Card group and the Tenders function.

The Start, Track, Field, and End settings should not be modified without 
specific instructions from the hardware dealer.
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To activate and configure the EDC Setup tab:

1. Select Maintenance > Store Settings > Credit Card group. The EDC Setup tab 
appears. See Figure 1-1 for QuickService. See Figure 1-2 for TableService.  

Figure 1-1  QuickService Store Settings - Credit Card Group - Setup Tab
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2. Select Enable EDC to activate the EDC functionality.
3. Select Use Aloha EDC to indicate you are using the Aloha EDC system for your credit 

card processing and not a third party system.
4. Select Mock Authorizations When EDC is Down to allow the FOH to perform ‘mock’ 

authorizations for sales less than a pre-defined amount if the EDC server is down. When 
the FOH loses connection to the EDC server and attempts to do a credit card authoriza-
tion, the system approves the authorization and the transaction is held as an .spl (spool-
ing) file in the EDC directory. When the connection is restored, the EDC program scans 
all spooling files to send them for approval. 

In SuperSite mode, the EDC program must read from a terminal file which includes all 
the terminals (Trm.dbf) and the matching store file (Sto.dbf). This allows EDC to iden-
tify the network names of all terminals. If any .spl files exist, they are sent through the 
normal authorization process. The approved ‘mock authorization’ transactions are indi-
cated on the Batch Transaction report with an * to the right of the authorization number. 

Figure 1-2  TableService Store Settings - Credit Card Group - Setup Tab

The monies from spooling files are not realized until EDC receives an authorization and 
settles a batch.
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All declined transactions are listed at the bottom. The ‘mock authorization’ mode is only 
activated when the BOH is down. If the BOH is up, ‘mock authorizations’ do not occur, 
even if the EDC program is turned off and is not processing requests. EDC is able to go 
into spooldown without losing network connection. 

5. Select Show message when EDC is down to display a notification when EDC is in 
spooldown. 

6. Type a dollar amount in ‘EDC Floor Down’ to represent the maximum mock authoriza-
tion amount. The system declines any mock authorization attempt over this dollar 
amount. The system does not allow a floor down amount less than $1.00. 

7. For TableService installations, select the credit card lookup ID. This designates a pre-
defined generic tender to search all active tenders based on the prefix number and detect 
the correct credit card type. 

8. Type threshold, in hours, that you are allowed between settling your credit card batches 
before a warning message appears on the Login screen in ‘Show Last Settlement Alert if 
More Than ___ Hours Ago.’ This option lets you know you need to run a settlement.

9. Select Only Read Track Two to designate the mag card reader (MSR) you are using, 
reads only track two of the magnetic stripe on a card. 

10. Select Do Not Allow Force Tenders to restrict you from forcing a credit card payment. 
When you select this option, the Force button does not appear on the FOH Close screen 
in TableService operations. 

11. Select Cannot use same credit card twice in a day to limit employees and guest from 
using the same credit card number more than once in the same business day. 

12. Type the number of ICVerify terminals you are using. This option is typically set to 
one. 

13. Type the percentage of the order in which to add to the check total to use to deter-
mine the authorization amount in ‘Assume This Tip% for Authorization.’ For example, 
if this tip percentage is set to 15%, and a customer charges $20.00 on a credit card, the 
authorization builds in 15% on top of the original $20.00 for a total authorization of 
$23.00. There is a leeway of + or - 20% for restaurants and + or - 15% for retail before a 
downgrade fee is charged. If a restaurant does not support tips, type 0.

14. Click Save. 

To allow a floor down amount less than $1.00, set the EDCNOFLOORLIMIT variable 
to TRUE in Aloha.ini.
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Defining Requirements for Pre-Authorization

Use the Authorization tab to define requirements and amounts for pre-authorization. This tab is
only available with the Aloha TableService product. 

The following procedure includes the required or suggested settings for setting up the Authoriza-
tion tab. Other settings on this tab, although available, are not discussed.

To define requirements for pre-authorization:

1. Select the Authorization tab from the Credit Card group. 

2. Select Perform Pre-Authorizations Automatically to automatically dial out to perform 
a pre-authorization when the check total exceeds the warning point. 

3. Type the initial dollar amount to use for automatic pre-authorization in ‘Amount.’ 
4. Type the dollar amount for subsequent increments over the pre-authorization 

amount in ‘Increment.’ For example, if the initial pre-authorization amount is $50.00 
and the increment amount is $25.00, the amount increases to $75.00 to send to the pro-
cessor for pre-authorization.

Figure 1-3  TableService Store Settings - Credit Card Group - Setup Tab
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5. Type the dollar amount at which point you want the system to warn the server that the 
guest check total exceeds the total pre-authorization amount in ‘Warning Point.’ The total 
pre-authorization amount is the initial amount and any incremented amount. When a pre-
authorized credit card total approaches the authorized amount, the system warns the 
server by changing the color at the top of the FOH guest check window to red.

6. Type increment amounts in the ‘Amount Selections’ text boxes for the employee to 
select when incrementing the pre-authorization amount. The amounts override the use of 
the amount entered in the ‘Increment’ text box. 

7. Click Save.

Customizing the Voucher

Use the Voucher Printing 1 and 2 tabs to enter customized voucher text, determine the voucher
print style, and define your credit card masking. 

The following procedure includes the required or suggested settings for setting up the Voucher
Printing tab. Other settings on these tabs, although available, are not discussed.

To customize the voucher:

1. Select the Voucher Printing 1 tab from the Credit Card group. See Figure 1-4 for Quick-
Service and Figure 1-5 for TableService.  

Figure 1-4  QuickService Store Settings - Credit Card Group - Voucher Printing 1 Tab
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2. Select the number of vouchers to print for each transaction. If using a printer with pre-
printed vouchers and carbon or NCR paper, select 1.

3. Type the text to print on the first voucher copy.
4. Type the text to print on the second voucher copy.
5. Type the text to print on the third voucher copy.
6. Type the text to print on the fourth voucher copy.
7. Select Print Large Text on Vouchers to print voucher text in a larger font size.
8. Select Print Check Message on Vouchers to print the guest check message text on 

credit card vouchers. To define a guest check message, select Maintenance > Messages > 
Guest Check Message.

9. Select the guest check message from the ‘Print Footer on Vouchers’ drop-down list to 
include a footer message on credit card vouchers. To define a footer message, click 
‘Message’ to access Guest Check Messages Maintenance.

10. Select Custom Text Lines on Sales Vouchers and type the text you want to appear on 
all sales vouchers.

11. Select Custom Text Lines on Refund Vouchers and type the text you want to appear on 
all refund vouchers. 

Figure 1-5  TableService Store Settings - Credit Card Group - Voucher Printing 1 Tab
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12. Select the Voucher Printing 2 tab. See Figure 1-6 for QuickService and Figure 1-7 for 
TableService.  

Figure 1-6  QuickService Store Settings - Credit Card Group - Voucher Printing 2 Tab

Figure 1-7  TableService Store Settings - Credit Card Group - Voucher Printing 2 Tab
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13. Select the Credit Card Number Mask method to designate the portion of the credit 
card or debit card number to appear on the voucher. Select from ‘Always show full num-
ber’, ‘Only show last 4 digits except on 1st voucher’, and ‘Only show last 4 digits on all 
vouchers’. If selected, the number is masked on the voucher, reprinted guest checks, and 
the Payment report.

14. Select Suppress Expiration Date to not print the credit card expiration date on the 
printed voucher. 

15. Select Suppress Cardholder Name to not print the name of the cardholder on the credit 
card voucher. When using a magnetic card reader, the system replaces the ‘Magnetic 
Card present: <cardholder name>’ line on the voucher with ‘Magnetic Card present: 
Yes.’

16. Click Save.

Defining Signature and Tab Name Requirements

Use the Options tab to define the signature required ceiling requirements and how the system
names tabs for unreadable cards. 

The following procedure includes the required or suggested selections for setting up the Options
tab. Other options on this tab, although available, are not discussed.
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To define signature and tab name requirements:

1. Select the Options tab from the Credit Card group. See Figure 1-8 for QuickService. See 
Figure 1-9 for TableService.  

Figure 1-8  QuickService Store Settings - Credit Card Group - Options Tab
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2. Type an amount in the ‘No Signature Required if less than ___’ text box to specify the 
minimum amount of credit card purchase to require a signature. If the purchase is less 
than the defined amount, a signature line does not print for the transaction. Type 0 to 
indicate all cards require a signature.

3. Select Manually Entered Cards to apply the ceiling specified for the ‘No Signature 
Required if less than ___’ option to all cards manually entered into the Aloha system.

4. Select Swiped Cards to apply the ceiling specified for the ‘No Signature Required if less 
than ___’ option to all cards entered in the Aloha system with a magnetic stripe reader.

5. Select System Names Tab to enable the system to associate a name with a tab when 
track one is unreadable, based on the first letter of the card type and the last four digits of 
the credit card number. For example, a tab named V5555 represents a Visa card with 
5555 as the last four digits of the credit card.

6. Select Prompt User for Tab Name to prompt you to enter the name to associate with a 
tab when track one is unreadable.

7. Select Print check at the Master, when EDC Voucher prints to print an additional 
check at the master printer whenever a voucher prints at the voucher printer. 

8. Select Print Void Slip to print a voided receipt from the original credit card transaction 
when you delete a credit card payment. The voucher reflects the full amount that was 
deleted, including the tip amount.

Figure 1-9  TableService Store Settings - Credit Card Group - Options Tab
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Creating Card Tenders

You must configure each type of card you accept as a tender type to process the card as a payment
from order entry terminals. Typically, there are three types of card tenders available:

Credit — Indicates the card carries an insignia, such as Visa, and the charge is posted to the
account. The guest receives a bill from the credit card company and pays the charge at a specified
time.

Debit — Indicates the card does not carry an insignia and the charge is immediately taken from
the bank account of the guest. A PIN entry is required to validate. Debit cards must require autho-
rization and identification. Currently debit cards must use either the NDC or Visanet processors,
and to allow PIN entry, interface with the VeriFone 1000, VeriFone Everest, and VeriFone Everest
Plus pin pads. 

Check — Indicates the card is a hybrid of a credit and debit card (check card) and carries an
insignia. The charge is immediately taken from the bank account of the guest, and can be used as
a credit card, or as a debit card requiring a PIN entry.

You can also utilize the Tip Refund feature. For a typical credit card charge, the restaurant pays a
1% or 2% processing fee. For AMEX, the fees are even higher, between 2% and 4%. If an
employee gets $20 in credit card tips, the restaurant is probably going to pay an extra $0.40 or
more in fees. In Tender maintenance, you can set up a Tip Refund % that will cause the Aloha
system to deduct the $0.40 from the employee’s tips. 

The following procedure includes the required or suggested settings for setting up a credit card
tender. Other settings in this function, although available, are not discussed.

Refer to the Debit Cards Feature Focus Guide for more information on configuring and 
using debit cards.
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To create a credit card tender:

1. Select Maintenance > Payments > Tenders. The Tenders function tab appears as the 
default tab. See Figure 1-10 for QuickService. See Figure 1-11 for TableService.  

Figure 1-10  QuickService Tenders - Tender Tab
4 Configuring Aloha EDC Aloha EDC User Guide v6.2



C
onfiguring

A
loha ED

C

2. Type an unused number and press Enter.
3. Type the name of the credit card, such as AMEX or VISA.
4. For TableService installations, assign a button position for the tender to appear on the 

FOH by using one of three options: 
a. Type a numeric button position in the ‘Button’ text box.
b. Select the First Available Button check box to place the button in the first available 

position. 

Figure 1-11  TableService Tenders - Tender Tab
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c. Click the Position button. The Button Position dialog box appears.   

5. Select the credit card type from the Report as drop-down list.
6. Select Active to indicate the tender is in use. 
7. Select Can Refund if you want the ability to refund transactions applied with this tender.
8. Select Print Check on Close.
9. Select Open Drawer on Close.
10. Select Print Signature Line to print a line on the voucher for the guest to sign.
11. Select Remove Tip Line if Auto Gratuity if you want to suppress the tip line when you 

apply automatic gratuity to the check.
12. Select Allow Tips, if applicable. 
13. Type the maximum tip percentage you can apply to this credit card. For example, type 

10.000 for 10%, 50.000 for 50%, etc. 
14. Type the tip refund percentage, to recover a percentage of credit card tips from employ-

ees to cover credit card processing fees. 

Figure 1-12  Button Position Dialog Box

For QuickService installations, you must place tenders on a panel. Refer to “Adding 
Credit Card Tender Buttons in QuickService” on page 1-31.
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15. Select the Type tab. See Figure 1-13 for QuickService. See Figure 1-14 for TableService.  

Figure 1-13  QuickService Tenders - Type Tab

Figure 1-14  TableService Tenders - Type Tab
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16. Select the card type from the ‘Credit Card’ drop-down list.
17. Select Do Not Print Vouchers. Use this option when you have indicated no voucher 

copies to print in Maintenance > Store Settings > Credit Card group > Voucher Printing, 
and you want a voucher to print only for this tender. 

18. Select Apply Signature Line Rules for Vouchers if you want the system to require a 
signature for this tender only when the check exceeds a specific amount.

19. Select Use Magnetic Card ONLY to require you to use a mag card reader for credit card 
input.

20. Select Print Expiration to set the credit card expiration date to automatically print on 
the guest check.

21. Select Signature Verification to enable the system to prompt you to verify the signature 
for the guest.

22. Select the Identification tab. See Figure 1-15 for QuickService. See Figure 1-16 for 
TableService.  

Figure 1-15  QuickService Tenders - Identification Tab
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23. Select Require Identification to prompt for a driver‘s license number, or any other iden-
tification associated with a payment.

24. Type the text to appear on order entry terminals when prompting for identification infor-
mation.

25. Type the minimum and maximum number of digits allowed in a credit card number.

Figure 1-16  TableService Tenders - Identification Tab
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26. Select the Authorization tab. See Figure 1-17 for QuickService. See Figure 1-18 for 
TableService.  

Figure 1-17  QuickService Tenders - Authorization Tab

Figure 1-18  TableService Tenders - Authorization Tab
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27. Select Require Authorization to prompt for an authorization on the order entry screen. 
28. Type the text to appear on order entry terminals when prompting for an authorization 

number.
29. Type the maximum length of an authorization number.
30. Select Print on Check to print the authorization code on the guest check.
31. Select Authorize Using EDC to specify Aloha EDC is used for credit card authorization. 
32. Select Allow PreAuth with EDC to specify Aloha EDC is used for credit card pre-

authorization. This is required for all tenders using the pre-authorization feature.
33. Click Save.
34. Repeat the procedure for all card tenders you accept at your store. 

Adding Credit Card Tender Buttons in QuickService

If you are using Aloha QuickService, you must use Panel Editor to add tender buttons to an
appropriate panel. For TableService installations, the tender buttons appear in accordance with
the button positions you assign to the tender, therefore, is not applicable.

To add a credit card tender button in QuickService:

1. Access Maintenance > Menu > Panel Editor. 
2. From the Commands menu, select Open Existing Panel > Button Functions to place 

the button on an existing panel. 
3. Select and open the panel currently used for tendering and closing orders.
4. If you are adding a new button, select Edit Panel from the Commands menu.

a. Clear the following three check boxes:
• Mark as Template
• Fixed Position
• Fixed Button Layout.

b. Select New Button from the Commands menu. The ‘Edit Buttons - QuickService’ 
dialog box appears.
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5. If you are editing an existing or unused button, right-click the button, and select ‘Edit 
Button.’ The ‘Edit Buttons - QuickService’ dialog box appears. 

6. Select Tender from the ‘Function’ drop-down list. 
7. Select the new debit tender from the ‘Tender ID’ list.
8. Type an appropriate name to appear on the new button, such as ‘Credit Card.’
9. Configure all settings, as required, in the Text, Background, and Bitmap sections of the 

Edit Buttons screen, using the Preview window as a guide, to give the button the desired 
appearance.

Figure 1-19  Tender Button Function
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10. Click OK to return to the panel, with the new button in place. 

11. Select Save All Panels from the Commands menu, and exit Panel Editor.

Figure 1-20  Sample Tenders Panel
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Configuring Aloha EDC
Once you configure the requirements in the Credit Card group and create credit card tenders, you
must configure the Aloha EDC interface, such as setting up store information, defining modems,
processors, and associating credit card types. Use the Configure menu within Aloha EDC to cus-
tomize the Aloha EDC system to fit the specific requirements for your restaurant.

To log in to the EDC program:

1. Launch the Aloha EDC program from the Start menu or a shortcut placed on the desk-
top. 

2. Click Log In (ALT+L). 

3. Type your user name.
4. Type your password.
5. Click OK. 

To log out of the EDC program, select File > Log Out.

Stopping POS Processing

To configure EDC, you must stop EDC processing to access the Configure menu. This disables
the EDC program from sending transactions and performing any authorizations or adjustments.
When you finish configuring EDC, you must restart POS Processing. 

Figure 1-21  Aloha EDC Login
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To stop POS processing:

1. Select File > Stop POS Processing. 

2. Click Yes. The Configure menu becomes available. 

Configuring Store Information

Use the Store Information menu option to establish the store name, address, and unit number.
EDC uses this information for reporting and as default information when setting up individual
processor records. 

Figure 1-22  Stop POS Processing Confirmation

Figure 1-23  EDC Configure Menu Dropdown
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To configure store information:

1. Select Configure > Store to access the Store Information dialog box. 

2. Enter the address and unit number for the store. 
3. Click OK.

Configuring Modems

Use the Modems menu option to establish the modem you are using to send transactions and
enter the COM port and a phone prefix, if required, used by the modem. We recommend using a
high speed modem with a baud rate over 9600; however, due to the limitations of some credit
card processors, you may have to turn off all modem intelligence. 

We also highly recommend you use an external modem, rather than internal. Credit card proces-
sors have very short time-outs when negotiating a connection. With advanced modem features
enabled, the modem takes too long when trying to establish a high-speed connection, and the pro-
cessor modem often disconnects before making a connection. 

Figure 1-24  Store Information Dialog Box

If the processor is Amex, at least a 9600 baud modem is required to settle a batch. 
Amex is the only processor that requires a modem faster than 2400 baud.
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What You Should Know Before Configuring a Modem

There are several common problems encountered when setting up a modem, all of which you
should solve before attempting to configure a modem and assign it to a processor. The most fre-
quently encountered difficulties are:

Incorrect COM port — This is a common problem encountered when installing internal
modems. Most internal modems have jumpers used to hardware-select both the COM port and the
IRQ. These jumper settings must match the software settings or the computer will not communi-
cate with the modem. Device conflicts are common when an internal modem and an on-board IO
port share the same IRQ. In this case, it is best to disable the on-board IO port using the conflict-
ing IRQ. This is seldom a problem with external modems.

Incorrect IRQ — As a general rule, IRQ settings cannot be shared between devices, thus when
two devices have been assigned the same IRQ, the result is a device conflict that prevents either
from functioning properly, if at all. Under normal circumstances, COM1 and COM3 are assigned
to IRQ 4, and COM2 and COM4 are assigned to IRQ 3. There are ways to configure Windows to
allow two COM ports to share an IRQ, however, it is recommended that the modem used by
Aloha EDC be assigned to its own IRQ and COM port. This is seldom a problem with external
modems.

Incorrect Init Strings — If an unlisted modem is installed, the correct register settings must be
entered for ‘Authorization Init String’ and ‘Settlement Init String’ located in Configure > Proces-
sors > Dialing Properties. An incomplete or incorrect initialization string does not normally pre-
vent the system from communicating with the modem, but can prevent the modem from making a
connection with the credit card processor. Consistent failure to connect is a common symptom of
an incorrect initialization string.

Telephone Line Interference — EDC requires a dedicated phone line. The phone line should
not interact with any internal telephone or PBX system. Static, crosstalk, or other examples of
degraded quality in the telephone system or phone lines will cause difficulties in modem connec-
tions with the processor. 

This guide does not document how to install modems. Refer to the documentation sup-
plied with the modem.
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Selecting a Modem

You must select a supported modem for EDC to use. You can configure multiple modems for a
restaurant, depending on your needs, such as one modem for handling transactions for all credit
card processors, a modem for each credit card processor, or multiple modems for the same credit
card processor. 

You may use a modem not listed; however, you must enter the correct initialization commands in
‘Authorization Init String’ and ‘Settlement Init String’ in the Dialing Properties for the processor.
Many communication problems are often traced to incorrect register settings in an initialization
string. To use a modem not in the list, click Cancel and type the modem name in ‘Description’ on
the Add Modem dialog box. Then type the correct initialization string information in the Dialing
Properties dialog box.

To select a modem:

1. Select Configure > Modems to display the Select Modems dialog box. 

2. Click Add to display the Add Modem dialog box. 

Figure 1-25  Select Modems Dialog Box

Figure 1-26  Add Modem Dialog Box
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3. Click Modems to display the Select Modem dialog box. 

Modems listed on the Select Modem dialog box have been tested with Aloha EDC and 
have the correct initialization strings stored in the system.

4. Select the modem and click OK. You are returned to the Add Modem dialog box with the 
selected modem. 

5. Click OK. You are returned to the Select Modems dialog box.
6. Type the following information.

Modem Number — Indicates a unique number to assign to the modem. You cannot
change the modem number

Description — Indicates the name of the modem. 

Com Port — Designates the com port to use for the modem. The default com port for a
selected modem is input here when a new modem is added. You can change this from the
default, if desired. The same com port cannot be used for separate modems. The com port
number is usually found on the back of your individual computer. If the specified com
port is used for another modem, an error message appears. 

Figure 1-27  Select Modem Dialog Box

Figure 1-28  EDC COM Port Error
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Click OK and type an unused com port to successfully add the record.

If you use multiple modems of the same type, we recommend adding the com port num-
ber to the end of the modem description. Modems are assigned to credit card processors
and this helps to differentiate between the modems. The default com port is assigned to
the new modem. Verify the com port number and change it, if needed.

Phone Prefix — Specifies the numbers that must be dialed prior to dialing the phone
numbers specified in the Configure > Processors > Dialing Properties dialog box. For
example, type 9 if a 9 must be dialed to get an outside line. 

7. Click Done.

Editing a Selected Modem

You may need to change the configuration of a modem, such as the com port number. These con-
figurations can also be performed when you select the modem. Click Configure to display the
Configure Modem dialog box and make the necessary changes.

Removing a Modem

To remove a modem from the list, select the modem from the Select Modems dialog box and
click Remove. The modem is removed from the list of available modems.

Configuring Gateways

Use the Gateways menu option to configure a secure portal, via the Internet, used to transmit and
convert encrypted information into a language that is compatible with the protocols used by the
receiving network. In terms of Aloha EDC, a gateway acts as a medium between the client and
the host to process credit card authorizations and settlements, using a method of encryption. The
client, or processor, communicates through the gateway using a Secure Socket Layer (SSL) con-
nection over TCP/IP, thereby, adding security and speed for transactions.

If the phone line is set up per EDC requirements, the phone prefix is not required. Add a 
comma to force the modem to pause before completing the dialing process.
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Currently, Aloha EDC supports the following gateways: 

• First Data IPN for CES and Nabanco
• Merchant Link for Amex (American Express)

After you establish the gateway connection, you must configure the individual supporting proces-
sor to use the gateway connection.

To configure a gateway connection: 

1. Select Configure > Gateways. The Gateway dialog box appears.  

2. Select the gateway connection. 
3. Click OK.

Configuring First Data (Datawire)

Use the First Data IPN option to provide an alternative method of sending transactions over the
Internet. First Data, also known as Datawire, is an Internet protocol network company that cur-
rently supports CES (First Data North) and Nabanco (First Data South). Most vendors choose this
method because it is cheaper and faster. It is especially helpful when using gift cards which
require very prompt replies from the processors. First Data (Datawire) configurations always
override TCP/IP settings or a modem in use. 

Figure 1-29  Select Gateway Dialog Box
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To configure the First Data IPN gateway:

1. From the Select Gateway dialog box, select First Data IPN and click OK. The First 
Data IPN Configuration dialog box appears.  

2. Type the IP address for connecting to First Data IPN in the ‘First (Primary)’ text box.
3. Type the port number for the first IP address.
4. Type the IP address to use for the second attempt to connect using First Data IPN when 

the first attempt fails, in the ‘Secondary IP’ text box.
5. Type the port number for the second IP address.
6. Click OK to return to the Select Gateway dialog box.
7. Click Cancel to save your configuration and exit the Gateways function. 

Configuring Merchant Link Gateway

Use the Merchant Link option to provide an alternative method of sending transactions over the
Internet for Amex (American Express). Most vendors choose this method because it is cheaper
and faster. Merchant Link configurations always override TCP/IP settings or a modem in use. 

Figure 1-30  Select Gateway Dialog Box

The default values in this dialog box are used for staging. You must type the IP host 
addresses and port numbers supplied by CES or Nabanco.
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To configure the Merchant Link gateway:

1. From the Select Gateways dialog box, select Merchant Link siteNet /M2 and click OK. 
The Merchant Link siteNet/M2 Configuration dialog box appears. 

2. Type the IP address, for connecting to Merchant Link, in the ‘First (Primary)’ text box.
3. Type the port number for the first IP address.
4. Type the IP address to use for the second attempt to connect to Merchant Link when the 

first attempt fails, in the ‘Second’ text box.
5. Type the port number for the second IP address.
6. Click OK to return to the Select Gateway dialog box.
7. Click Cancel to save your configuration and exit the Gateways function

Figure 1-31  Select Gateway Dialog Box

To ensure network connectivity to the gateway, you can navigate to https://
gateway1.nxt.com:8442/test.cgi and test the connection using the test cards supplied by 
American Express. Upon approval, American Express returns with the response, ‘cgi is 
working.’
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Configuring Processors

Use the Processors menu option to select and configure the credit card processors used by the
restaurant. These processors are used to send transactions to the host or bank for authorization,
adjustments, settlements, and other options. 

What You Should Know Before Configuring Processors 

Before you can configure a processor, you must first obtain client information from the location
and processor information from the host using the Aloha EDC processor worksheets supplied by
Radiant Systems, including Merchant ID, Terminal ID, Internet addresses, TCP/IP settings,
phone numbers, and more. 

There are several methods of communication used in the industry for processors to submit data.
Internet-based processors is the preferred method to use for faster responses and security; how-
ever, some processors do not support Internet communication, or the functionality is not sup-
ported in Aloha EDC. In any case, if your EDC connection is not cable or DSL, you cannot use a
processor via the Internet. The following methods of communication used for processors are
available, where applicable:

TCP/IP Internet Secure or Encrypted Support (SSL) — Sends transactions across the public
Internet as secured and encrypted packets. If you configure the processor to support TCP/IP and
dial-up, Aloha EDC uses the TCP/IP connection first, then resorts to dial-up support as a back-
up.

TCP/IP Frame Support — In general, sends transactions from within a network, rather than
across the Internet. If you configure the processor to support TCP/IP and dial-up, Aloha EDC
uses the TCP/IP connection first, then resorts to dial-up support as a back-up.

Gateway Support — Acts as a medium between the client and the host through a secure socket
layer connection over TCP/IP. Refer to “Configuring Gateways” on page 1-40 for more informa-
tion. 

Dial-up Support — Uses a dedicated telephone line to dial out to the host. Dial-up support is the
slowest of these communication methods and you may experience busy signals more frequently.

Refer to the EDC Processor Worksheets for forms to use to send to sites. 
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If you configure the processor to support TCP/IP and dial-up, Aloha EDC uses the TCP/IP con-
nection first, then resorts to dial-up support as a back-up. 

Adding a Supported Processor

You must add a supported processor for EDC to use. You can configure multiple processors for a
restaurant, depending on your needs, such as one processor for handling authorizations, and a one
for settlement. You may also use these processors to emulate other processors not listed, however,
Radiant Systems does not support these. 

To add a processor:

1. Select Configure > Processors to display the Select Processor dialog box. 

The Select Processor dialog box displays the current selections defined for use by the res-
taurant.

2. Click Add to display the Select Processor to Add dialog box. 

Figure 1-32  Select Processor Dialog Box

Figure 1-33  Select Processor to Add Dialog Box
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3. Select the processor to use.
4. Type the Store Index number, if necessary.

Store Index — Used to set up multiple merchant IDs for the same credit card processor,
but normally set to ‘1.’ For example, if you already defined CES as a processor, and
require another CES record with a different merchant ID, set the Store Index to ‘2’ on the
second record. The system combines the processor name and the specified store index to
create a new processor (in this example, CES2). The store index number does not have to
be incremented in sequential order. 

5. Click OK. The configuration dialog box for the selected processor appears. 

6. Type the information for the processor and click OK to return to the Select Processor 
dialog box.

7. Click OK to exit the Processors function.

Configuring a Processor

You must configure the processor to communicate with the FOH and the respective host. With
these configuration dialog boxes you can enable the processor to send transactions over a TCP/IP
connection, if supported. 

Most configuration dialog boxes contain the following options: 

Enable Multi-trans — Enables multiple authorization transactions during a single dial-up con-
nection. This is necessary when the system has initiated an authorization call to a processor and a
second authorization request is sent from an order entry terminal in the FOH. When you select
this option, the system passes the second authorization request to the processor before hanging up
the connection, substantially speeding up the transaction. ‘Enable Multi-trans’ is selected by
default on all the configuration dialog boxes in EDC, except NPC. Clear this option, if you allow
only one authorization per call.

Remove rejected transactions — Enables EDC to remove rejected transactions from a settle-
ment batch and logs a Reject.txn file to the current batch, similar to a voided transaction. This
functionality is used in conjunction with Functions > Edit Rejected Transactions. Some processor
dialog boxes have this option grayed out so you cannot select it.

Refer to “Configuring a Processor” on page 1-46 for information on configuration 
requirements for each processor. 
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Dialing Properties

If the processor configuration dialog box has a Dialing tab or button, then the processor supports
a dialup connection. Some processors only offer dialup support. In the processor configuration,
click the Dialing button or select the Dialing tab to display the Dialing Properties.

Some sites now rely solely on a broadband connection to use for their secure socket layer (SSL)
authorizations and do not install an analog modem on the BOH computer. The typical protocol for
Aloha EDC is in the event the system cannot connect to the host, via an SSL connection, the sys-
tem automatically attempts a dial-up connection, regardless if a physical modem is installed. This
causes delays for each transaction while the system tries to find the modem to dial out. If you are
using Paymentech, you can configure the Paymentech processor to not roll over to a modem con-
nection. Do this by selecting ‘No modem failover’ in the Paymentech processor dialog box. 

Phone Numbers Group Box

Use the Phone Numbers group box to enter the appropriate phone numbers to call for authoriza-
tion. These numbers are found in the processor worksheets returned from the site, and are sent to
the modem as part of the dialing string when initiating a call to the processor. If the information

Figure 1-34  Dialing Properties Dialog Box
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on the worksheets has not already been filled out, contact the processor to obtain the needed
information. 

Settlement Processor Group Box

Use the Settlement Processor group box to indicate an intermediary processor used to settle, in
case the usual processor is down. Select the intermediary processor from the drop-down list.
Only the processors you have selected appear in the list. 

To use an unlisted processor as an intermediary:

1. Select OK on the Dialing Properties dialog box to save the data already entered. 
2. Click OK on the Processor Configuration dialog box. 
3. Select Configure > Processors to display the Select Processor dialog box. 
4. To add the intermediary processor, click Add, select the desired processor, and click OK. 
5. Return to the original Dialing Properties dialog box, and select the new processor from 

the ‘Settlement Processor’ drop-down list.

Modem Group Box

Use the Modem group box to define the current modem, authorization init string, and ‘Authoriza-
tion Init’ string. You can use high speed modems (over 9600 baud) with Aloha EDC, but due to
the limitations of credit card processors, you must turn off all modem intelligence. Credit card
processors have very short timeouts when negotiating a connection. With advanced modem fea-
tures enabled, the modem takes too long when trying to establish a high-speed connection. The
processor modem often disconnects before making a connection.

If you install an unlisted modem, it is up to you to enter the correct register settings for ‘Authori-
zation Init String’ and ‘Settlement Init String’ located in the Dialing Properties dialog box. An
incomplete or incorrect initialization string does not normally prevent the system from communi-
cating with the modem, but can prevent the modem from making a connection with the credit
card processor. Consistent failure to connect is a common symptom of an incorrect initialization
string.

If you must type a phone prefix, such as 9, before dialing the phone number, do not 
type the prefix as part of the phone numbers. You enter this information in ‘Phone Pre-
fix’ on the Add Modems dialog box.
8 Configuring Aloha EDC Aloha EDC User Guide v6.2



C
onfiguring

A
loha ED

C

Each initialization string should begin with the Attention Command (AT) followed by the com-
mands to: 

• Reset modem to factory settings.
• Disable DCE flow control.
• Disable v.42/MNP data compression.
• Disable XON/XOFF or RTS/CTS flow control.
• Enable direct data link only.

Consult the user manual shipped with the modem and determine the appropriate commands. 

For example, the init string for a Hayes modem is ATZ&K0&M0&C1&D2 where: 

For example, the init string for a GVC 14.4 modem is AT&F5%C0\\G0\\Q0\\N1S11=50 where: 

AT Attention command. Alerts modem to subsequent commands.
Z Resets factory defaults. 
&K0 Disables flow control.
&MO Turns off the modem speaker.
&C1 Turns DCD on when the carrier from the remote modem is detected.
&D2 Sets the Data Terminal Ready status to that needed by Aloha EDC. 
\S Additional register setting to the Init String by adding S??= where ?? is the S-

register to set, followed by the desired number to the right of the equal sign.

Most modems have register settings to set the modem’s dialing speed. Set the modem’s 
dialing speed to 50 milliseconds to speed up the authorization process.

AT Attention command. Alerts modem to subsequent commands.
&F5 Resets factory defaults. This is important, otherwise you may    end up with an

init string that works on one modem but not    another, due to a setting which is
not in the init string.

%C0 Compression off
\G0 Disable DCE flow control
\Q0 Hardware flow control off
\N1 Direct data link only
S11=50 Set touch tone time to 50 milliseconds. This enables quicker    dialing.
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Current Modem — Specifies the supported modem defined in Configure > Modems. When you
select a modem, the corresponding initialization strings used by the modem when performing
credit card authorizations and settlements are automatically populated.

Authorization Init String — Automatically populates when you select a modem. If you have
not configured the modem, you must ensure the correct initialization string characters are
entered. If you select a user-defined modem, the default initialization string of ‘AT&F0’ is placed
in the field and the correct data must be determined and manually entered. A separate initializa-
tion string is entered for credit card authorization and credit card settlement. This allows different
modem commands to be used. 

Settlement Init String — Automatically populates when a modem is selected in the ‘Current
Modem’ text box. If you have not configured the modem, you must ensure the correct initializa-
tion string characters are entered. If you select a user-defined modem, the default initialization
string of ‘AT&F0’ is placed in the field and the correct data must be determined and manually
entered. 

Configurable Baud Rates Group Box

Use the Configurable Baud Rates group box to determine the baud rate for authorization and set-
tlement. Do not use these settings for the American Express processor.

Authorization Baud Rate — Designates the baud rate used for the modem connection during
authorization. Do not use these settings for American Express.

Settlement Baud Rate — Designates the baud rate used for the modem connection during set-
tlement. Do not use these settings for American Express.
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Supported Processors

The following table provides an overview of the processors supported by Aloha EDC: 

Processor Card Type Dial Up TCP/IP SSL

$$$ in the Bank Credit cards
Debit cards (Canadian Debit)

Yes No No

AlohaNet Credit cards No Yes No

Amex Credit cards Yes Yes No

BA Merchant Services Credit cards Yes No No

CES Credit cards Yes Yes Yes

Gift cards (ValueLink) Yes Yes No

Concord EFS Credit cards Yes Yes No

DirectNet Credit cards No Yes No

FDC Credit cards Yes No No

Fifth Third Bank Credit cards Yes Yes Yes

Gift cards (Fifth Third) Yes Yes Yes

Global Payments Credit cards Yes No No

Debit cards Yes No No

Check authorization Yes No No

Maverick Credit cards Yes No No

Nabanco Credit cards Yes Yes Yes

Gift cards (ValueLink) Yes Yes No

Nova Credit cards Yes No No

Paymentech Credit cards Yes Yes Yes

Gift cards (Paymentech) Yes Yes Yes

RBS Lynk Credit cards Yes Yes Yes

Stored Value Systems Credit cards Yes Yes No

Gift cards Yes Yes No

Visanet Credit cards Yes Yes Yes

Debit cards Yes Yes No
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$$$ In The Bank  

Aliases
Shift 4, 
Dollars in the Bank, 
$$$ on the Net

Supported Card Types Credit cards (v4.4, and above)

Supported Communication TCP/IP Frame (v4.4, and above)

Notes: 

Figure 1-35  $$$ In the Bank Configuration Dialog Box
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Alohanet   

Aliases
Supported Card Types Credit cards (v5.2, and above)

Supported Communication TCP/IP Frame (v5.2, and above)

Notes: Alohanet is used as a generic credit card processor and part of the Universal Payment 
Interface (UPI). Contact the third party credit card processor for information pertaining to the 
Custom Setting text boxes.

Figure 1-36  AlohaNet Dialog Box
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Amex  

Aliases American Express

Supported Card Types Credit cards (v3.5, and above)

Supported Communication
TCP/IP Frame (v4.4, and above)
Merchant Link Gateway for authorization only (5.3.29, and 
above)
Dial-up (v3.5, and above)

Notes: 

Figure 1-37  Amex - Setup Tab
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BA Merchant Services 

Aliases Formerly NPC

Supported Card Types Credit cards (v3.5, and above)

Supported Communication Dial-up (v3.5, and above)

Notes: This processor was named NPC for v3.5 to 5.3.20.

Figure 1-38  BA Merchant Services Dialog Box
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CES 

 

Aliases
FDMS North, 
Cardnet, 
First Data North

Supported Card Types Credit cards (v3.5, and above)
ValueLink Gift cards (v5.2.5, and above)

Supported Communication
TCP/IP SSL for credit cards only (v5.2.5, and above)
TCP/IP Frame (v5.2.5, and above)
Datawire IPN Gateway (v5.2.5, and above)
Dial-up (v3.5, and above)

Notes: CES supports a maximum of 349 transactions per batch. 

Figure 1-39  CES - Options Tab
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Figure 1-40  CES - TCP/IP Tab
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Concord EFS 

Aliases Formerly BuyPass

Supported Card Types Credit cards (v4.4, and above)

Supported Communication TCP/IP SSL (v5.3.6, and above)
Dial-up (v4.4, and above)

Notes: This processor was named BuyPass for v4.4 to v5.3.6.

Figure 1-41  Concord EFS - Options Tab
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Figure 1-42  Concord EFS - TCP/IP Tab
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DirectNet 

 

Aliases POSWare

Supported Card Types Credit cards (v4.4, and above)

Supported Communication TCP/IP Frame (v5.2.5, and above)
Datawire IPN Gateway (v5.2.5, and above)

Notes: 

Figure 1-43  DirectNet Dialog Box
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FDC  

Aliases

FDR, 
Envoy, 
FDR Omaha (back-end only), 
First Data National,
First Data Nashville

Supported Card Types Credit cards (v3.8, and above)

Supported Communication Dial-up (v3.8, and above)

Notes: 

Figure 1-44  FDC Dialog Box
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Fifth Third Processing Solutions 

  

Aliases Fifth Third Bank

Supported Card Types Credit cards (v5.3, and above)
Fifth Third Bank gift cards (v5.4.1, and above)

Supported Communication
TCP/IP SSL (v5.3, and above)
TCP/IP Frame (v5.3, and above)
Dial-up (v5.3, and above)

Notes: 

Figure 1-45  Fifth Third Processing Solutions - Setup Tab
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Figure 1-46  Fifth Third Processing Solutions - TCP/IP Tab
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Global Payments 

Aliases Formerly NDC

Supported Card Types
Credit cards (v3.6, and above)
Debit cards for QuickService only (v5.2, and above)
Check authorization for BOH only (v3.6, and above)

Supported Communication Dial-up (v3.6, and above)

Notes: This processor was named NDC for v3.6 to v5.3.20.

Figure 1-47  Global Payments - Setup Tab
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Maverick 

Aliases Card Systems

Supported Card Types Credit cards (v4.2, and above)

Supported Communication Dial-up (v4.2, and above)

Notes: 

Figure 1-48  Maverick Dialog Box
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Nabanco 

  

Aliases FDMS South,
First Data South

Supported Card Types Credit cards (v3.65, and above)
ValueLink gift cards (v5.2.5, and above)

Supported Communication
TCP/IP SSL (v5.2.5, and above)
TCP/IP Frame (v5.2.5, and above)
Dial-up (v3.65, and above)

Notes: 

Figure 1-49  Nabanco - Setup Tab
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Figure 1-50  Nabanco - Options Tab

Figure 1-51  Nabanco - TCP/IP Tab
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Nova 

Aliases
Supported Card Types Credit cards (v3.8, and above)

Supported Communication Dial-up (v3.8, and above)

Notes: 

Figure 1-52  Nova Dialog Box
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Paymentech   

Aliases Paytech

Supported Card Types Credit cards (v4.4, and above)
Paymentech gift cards (v5.2.5, and above)

Supported Communication
TCP/IP SSL (v5.3, and above)
TCP/IP Frame (v5.3.4, and above)
Dial-up (v4.4, and above)

Notes: 

Figure 1-53  Paymentech - Setup Tab
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Figure 1-54  Paymentech - Options Tab
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Figure 1-55  Paymentech - TCP/IP Tab
Aloha EDC User Guide v6.2 Configuring Aloha EDC 1 – 71



1 – 7
RBS Lynk  

Aliases LynkSystems
Lynk

Supported Card Types Credit cards (v4.2, and above)

Supported Communication
TCP/IP SSL (v5.2.5, and above)
TCP/IP Frame (v5.2.5, and above)
Dial-up (v4.2, and above)

Notes: RBS Lynk is in direct partnership with Radiant Systems. For v5.2, and below, use 
Visanet as an RBS Lynk emulation. For v5.2 to v5.3.20, use the Lynk processor.

Figure 1-56  RBS Lynk Dialog Box
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Stored Value Systems 

Aliases

Supported Card Types
Credit cards (v5.3, and above)
Stored Value gift cards (5.3, and above)
Accepts cards formatted for Aloha eCard (6.2, and above)

Supported Communication TCP/IP Frame (v5.3, and above)
Dial-up (v5.3.21e, and above)

Notes: 

Figure 1-57  Stored Value Systems - Setup Tab
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Visanet 

 

Aliases Currently named Vital
Vitalnet

Supported Card Types Credit cards (v3.5, and above)
Debit cards for QuickService (v5.2.7.90, and above)

Supported Communication
TCP/IP SSL (v5.2, and above)
TCP/IP Frame (v5.2.7.90, and above)
Dial-up (v3.5, and above)

Notes: 

Figure 1-59  Visanet Dialog Box
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Configuring Private Label Cards

Use the Private Label Cards function to configure cards owned by private institutions, such as a
Sears card or a campus meal card. Typically, these would be cards that carry credit for purchases,
but are valid only if used at a location found within the company, such as an in-house cafeteria. 

To configure a private label card:

1. Select Configure > Private Label Cards. The Configure Private Label Cards dialog 
box appears. 

2. Select an unused record from the ‘Card to Configure’ drop-down list. 

Card to Configure — Denotes the private card. Choose from Private1, Private2,
Private3, Private4, or Private5. You can configure up to five private label cards.

3. Type the name of the private label card.
4. Type a high and low range for the card.

High Range — Denotes the eight-digit prefix of the card number, which represents the
upper range of card numbers.

Low Range — Denotes the eight-digit prefix of the card number, which represents the
lower range of card numbers.

Figure 1-60  Configure Label Cards Dialog Box
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5. Type a minimum and maximum length for the card.

Max Len — Designates the maximum card digit length.

Min Len — Designates the minimum card digit length.

Optional — Denotes any additional information about the private label card.

Check Digit — Verifies the number of digits in the private label card.

Expiration Date — Specifies a required entry of the expiration date for private label card
approval.

Assigning Cards to Processors

Currently, Aloha EDC provides for these major credit cards: MasterCard, VISA, American
Express, Diners, Carte Blanche, Discover, Enroute, JCB, and Military. The Aloha system recog-
nizes Diners and Carte Blanche as being the same, thus you should configure Diners/Carte
Blanche as one credit card type in the Maintenance > Payments > Tenders function. 

To assign cards to processors:

1. After you configure your processors, select Configure > Cards. The Assign Cards to 
Processors dialog box appears. 

Figure 1-61  Assign Cards to Processors Dialog Box
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2. In the Common Credit Cards group box, select the processor to use for each card type. 
Unless you are using multiple processors, you would use the same processor for all 
types. Select ‘None’ for any card you do not accept.

3. In the Private Label Credit Cards group box, select the processor to use for each pri-
vate label card type. Unless you are using multiple processors, you would use the same 
processor for all types. Select ‘None’ for any card you do not accept.

4. In the Gift Cards group box, select the processor to use for the corresponding gift card 
you accept. In most cases, such as Paymentech and Stored Value, you can select only 
one supporting processor for the gift card. Select ‘None’ for any card you do not accept.

5. In the Other Cards group box, select the processor to use for the debit card you accept. 
Select ‘None’ for any card you do not accept.

6. Click Save. 

Defining Additional EDC Options

Use the Options function to define a maximum refund amount for credit cards and how many
times an SSL connection will attempt to dial out. 

1. Select Configure > Options to display the EDC Options dialog box. 

2. Type the credit card refund limit.

Credit Card Refund Limit  — Sets the maximum, amount up to $9999.00, you can
refund a credit card. Use this function to prevent users from entering incorrect amounts
accidentally.

3. Type the number of times to process EDC transactions via dialup before trying to 
connect through SSL. 

Figure 1-62  EDC Options Dialog Box
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‘Retry SSL Every ___ Connections — Defines the consecutive number of attempts 
Aloha EDC uses a dial-up connection before attempting to connect via an SSL connec-
tion. This reduces the time spent waiting for a message that the SSL connection is down. 
For example, if you enter three, the system will notice the Internet connection is lost, use 
a dial-up connection for three consecutive transactions, and attempt an SSL connection 
on the fourth transaction.

4. Click OK.

Starting POS Processing

After you configure the Aloha EDC program, you must start POS processing for the EDC pro-
gram to communicate with the FOH and process transactions. 

To start POS processing, select File > Start POS Processing.
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Defining an EDC Processing Path
Aloha EDC has the ability to directly specify an EDC processing path for EDC and for the FOH.
This is necessary to support multiple stores using an EDC server, or to support a separate EDC
server, which is not on the BOH. By using the \EDCPath command line option or EDCPath envi-
ronment variable, this overrides the FOH communicating with EDC using the <iberdir>\EDC
directory. For example, if you have a dedicated credit card server named CCServer, you could set
up your FOH icons as Iber/EDCPath \\CCServer\BootDrv\Aloha\EDC or IberEDCPath
\\CCServer\BootDrv\AlohaQS\EDC, which forces all .req and .ans files to go to the specified
directory. The EDC running on the CCServer should use the same EDCPath. 
0 Configuring Aloha EDC Aloha EDC User Guide v6.2
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Editing EDC.ini
EDC.ini is a file that contains all configuration settings defined within Aloha EDC, such as pro-
cessor specific dialog box information, settlement attempts, debout information, and modem
setup information. EDC.ini is located in the C:\Aloha\EDC or C:\AlohaQS\EDC directory. You
can manually edit the items within EDC.ini; however, we strongly recommend you make all
changes from within the Aloha EDC program itself. 

The following variables are found in EDC.ini:

MultipleMerchantIDs Variable in EDC.INI — Affects how credit card batch files increment.
If the variable does not exist or is set to FALSE, the default is multi-site mode. If the variable is
set to TRUE, then each processor requires its own Merchant ID. Edit EDC.ini to set this variable.
Note: When Nova is the credit card processor, the variable is always treated as TRUE. The Nova
processor must have multiple Merchant IDs because Nova is a hybrid processor.

MultipleMerchantIDs — Determines whether credit cards are authorized under a single account
or separate accounts. 

If MultipleMerchantIDs is set to FALSE, credit cards are authorized under a single account with
the credit card processor, such as Visanet. At the same time, transactions report in the Aloha sys-
tem as if they were going into many different accounts at Visanet.

The advantage is that the merchant does not have to purchase multiple Merchant IDs, and the
credit card processor reports a single total for all terminals and stores. Some people like this cen-
tralized reporting with a single total of their money. If the merchant needs a break down by termi-
nal or store, the Aloha system can provide the subtotal breakout. This is the single Merchant ID
concept and corresponds to MultipleMerchantIDs = FALSE. This is done by allowing terminals
to be assigned their own directory or batch. Setting the processor Store Index field in Configure >
Processors creates a directory for each index, for example; Visanet, Visanet2, Visanet3. 

The MultipleMerchantIDS variable is the only variable within EDC.ini that must be 
manually edited.
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On the other hand, some people do not like their money accounts combined and want to use sep-
arate accounts with the credit card processor for each store or terminal. This allows them to
receive a separate report from the credit card processor for each store or terminal. This corre-
sponds to MultipleMerchantIDs = TRUE. This method requires a separate account with the
credit card processor for each instance of a processor added in EDC.

Batch Incrementing — Actually, there is not much difference in the two methods except when
credit card processors have batch numbers associated with each transaction. For processors that
have batch numbers (Visanet, Maverick, Paymentech) it is important to increment this number in
different ways depending on the method that applies. For the first method, there is really only one
batch, even though it is separated into multiple subdirectories, and each subdirectory is settled
separately. For the second method, it is important that each batch be incremented separately upon
settlement. Basically, the MultipleMerchantID flag controls how the batch number is treated in
the Aloha system.
2 Configuring Aloha EDC Aloha EDC User Guide v6.2
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Understanding the Aloha EDC File Process
After you complete the installation requirements and start POS processing, the EDC transactions
are processed seamlessly from the FOH to the EDC server. The flowchart below demonstrates the
normal file process for credit card transactions, assuming no mock authorizations are performed.  

As you apply credit cards in the FOH, the master terminal creates an .req (request) file on the
EDC server in the \EDC directory. 

In a live situation, EDC usually scans for .req files on an average of once per second. When an
.req file is found, EDC immediately converts it to an .hld (hold) file with the same name in the
\EDC directory, indicating that processing has begun. If POS processing is off, or EDC is not run-
ning, then the .req file is not picked up. In this case, the FOH times out after three minutes and an
‘Err/No Response’ message is received. 

When there is a response, the .hld file is converted to an .ans file in the \EDC directory. After
EDC processes the .req file, the response is written to an .ans (answer) file and the .hld file is
deleted. The .ans file is basically identical to the .req file, but the Approved field indicates
whether the action succeeded, and the Auth or Error fields provide additional information. 

If there is not a response, and you are set up to perform mock authorizations, spooldown is acti-
vated. The .hld file is converted to an .spl (spooling) file, with the same name in the \EDC direc-
tory. This is done on the master terminal, which may or may not have an EDC directory. If not,
one is created at this time.

Figure 2-1  EDC File Process

If you are set up to perform mock authorizations when the server is down, a spool file 
(.spl) is immediately created in the \EDC directory. Once the file server is available, .spl 
files go through the normal file process for authorization.
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Once the response is written to an .ans file, EDC writes the response to a .txn (transaction) file in
the processor specific directory for the processor, which is handling the batch for the transaction.
The .txn files are sequentially numbered, and have identical contents as the .ans files. The .txn
files in a processor specific directory make up the current batch for that processor. The .ans file is
then deleted.

If a BOH adjustment is made, .txn and .ans files are also generated. The FOH picks up the .ans
file and updates the FOH with the BOH changes. If the EDC program goes down while process-
ing an action, then the .hld file is left in the \EDC directory. When EDC starts, it scans for any
.hld files. If EDC finds .hld files, it errors all of them out because it does not know if they pro-
cessed or not. This is indicated by the 'HLD File not processed' error message.

Once the settlement is complete, the .txn files are deleted from the directory of the processor and
replaced with .stl (settlement) files with the format of: YYYYMMDD.stl, where YYYYMMDD
is the current date. If a settlement already exists with that file name, the settlement file is named
YYYYMMDD.A, YYYYMMDD.B, and so on. The .stl files accumulate until they are manually
deleted and are pulled for reporting purposes.

The time-out for how long the FOH waits for EDC to dial can be configured in seconds by add-
ing a variable to Aloha.ini. Edit the WaitForEDCRename variable in Aloha.ini. Set the value to n
where n is the number of seconds to wait until EDC renames the .req file. After the specified
number of seconds has elapsed, the .req file is deleted and renamed with an .hld extension. 
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Viewing the Aloha EDC Main Screen
Use the Aloha EDC main screen to view the transaction activity, per card, processed through
EDC. You also determine the status of the processors in use, when you last settled a batch, and if
POS processing is on or off. 

If you have any offline gift card transactions that occurred while EDC cannot connect to the gift
card host, the total appears in red at the top of the screen. To realize the monies from these trans-
actions, you must review and process these transactions. 

To log in to the EDC program:

1. Launch the Aloha EDC program from the Start menu or from a shortcut placed on the 
desktop. 

2. Click Log In (ALT+L). 

3. Type your user name.
4. Type your password.
5. Click OK. 

Refer to the gift card feature focus guide pertaining to the gift card you are using, for 
more information on gift cards.

Figure 2-2  Aloha EDC Login
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6. Click Yes. The Aloha EDC main screen appears. 

This screen displays the current transaction activity, including totals by card for all transactions
in the current batch. It is updated as new requests are passed from FOH order entry terminals to
Aloha EDC, and provides running totals and a monitor on the credit card activities. The top por-
tion of the screen is used to display modem activity as it occurs, such as when the modem is con-
necting/disconnecting, whether a batch is settling, and more. The POS status displays, indicating
whether POS processing is active or not. 

Figure 2-3  EDC Main Screen

POS processing should be active at all times, except during setup and configuration.

number of transactions 
since last batch settlement

date, time, and processor 
used in the last batch set-
tlement.

menu bar

status

current 
transaction 
activity

number of 
offline 
transactions 
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Performing EDC Functions from the BOH
Functions such as authorizing, adjusting, forcing, preauthorizing, refunding, and voiding transac-
tions are normally preformed from the FOH, and should be done whenever possible, however,
you can perform these functions from the BOH, for your convenience or when the FOH is down.
The Functions menu contains the commands used to make manual entries and adjustments, as
well as the batch processing commands. 

When you use the Authorize, Force, Preauthorize, and Refund commands, the action is indepen-
dent of the FOH. These actions are not assigned to a specific check and they do not affect totals
on the FOH. Manual transactions are, however, written to the current batch file and become a part
of the permanent record.

When you use the Adjust and Void commands, the action is dependent on the FOH because the
transaction originally started with a check on the FOH. These actions require access to the check
and the transaction appears on the appropriate check. The adjusted amount appears on totals on
the FOH.

Figure 2-4  Functions Menu
Aloha EDC User Guide v6.2 Using Aloha EDC 2 – 7



2 – 8
Authorizing a Transaction from the BOH

Use the Authorize function to enter a manual transaction independent of the FOH. Transactions
entered using the Authorize function become part of the current batch, but are not associated with
a guest check on the FOH. This is used in special circumstances that require the user to override
or supplement FOH transactions. If at all possible, cards should be authorized and scanned from
the FOH. 

To authorize a transaction from the BOH:

1. Select Functions > Authorize to display the Authorize dialog box. 

2. Type the card number, card expiration date, amount, and tip information.
3. Click OK to initiate the authorization process. An approval number is received with 

authorization.

Adjusting a Transaction from the BOH

Use the Adjust function to modify a previous credit card transaction entry after the End-of-Day
has been processed and the batch has not been settled, or when the original transaction was gen-
erated using the Authorize function. If the transaction to be adjusted originated on an order entry
terminal in the FOH, the adjustment should be done from the FOH, if possible. 

Figure 2-5  Authorize
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To adjust a transaction from the BOH:

1. Select Functions > Adjust to display a list of transactions to adjust. 

2. Select the transaction to adjust and click OK. The Adjust dialog box with the transaction 
detail appears. 

Figure 2-6  Select Transaction to Adjust

Figure 2-7  Adjust Dialog Box
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3. Type the new amount and click OK to save the adjustment. A confirmation message 
appears. 

4. Click OK.

Forcing a Transaction from the BOH

Use the Force command as a backup procedure to use when a card will not process automatically,
or when the processor requires manual authorization for a card. Forced transactions are not
reflected on FOH order entry terminals. In most cases, the force command is used in conjunction
with a telephone call to the processor help desk. It does not originate the telephone call. You must
initiate a voice connection to the processor help desk and obtain the approval code. 

To force a transaction from the BOH:

1. Select Functions > Force to display the Force dialog box. 

2. Type the card number, expiration date, amount, tip, and approval code received from 
the help desk. 

3. Click OK to save the information. 

Figure 2-8  Adjustment Result

Figure 2-9  Force Dialog Box
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Preauthorizing a Transaction from the BOH

Use the Preauthorize command to manually enter a preauthorization transaction and originate a
phone call to the assigned card processor. Transactions entered using the Preauthorize function
are not reflected on the FOH. Any transaction that has been preauthorized is written to the current
batch. Batch totals are not affected unless the transaction is adjusted using the Adjust function. By
default, the settlement amount is set to zero. Preauthorization transactions entered using this func-
tion are recalled later using the Adjust function, where they are completed. 

To preauthorize a transaction from the BOH:

1. Select Functions > Preauthorize to display the Preauthorize dialog box. 

2. Type the card number, expiration date, and amount.
3. Click OK. The system automatically initiates the preauthorization process. 

Refunding a Transaction from the BOH

Use the Refund command to issue a refund to a customer and credit their account. A refund posts
a credit amount to the current batch. It does not affect FOH totals, nor does it dial out. Refunds
can be deleted using the Void function. 

Figure 2-10  Preauthorize Dialog Box
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To refund a transaction from the BOH:

1. Select Functions > Refund to display the Refund dialog box. 

2. Type the card number, expiration date, amount, and reason for the refund. The 
Amount is entered as a positive number. 

3. Click OK. The system writes the refund to the current batch, and the confirmation 
prompt appears. 

4. Click OK to complete the transaction.

Voiding a Transaction from the BOH

Use the Void command to void or refund a transaction initiated from the FOH and from the cur-
rent batch. A void must be performed before the batch is settled. 

Figure 2-11  Refund Dialog Box

Figure 2-12  Result Dialog Box
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To void a transaction from the BOH:

1. Select Functions > Void to display a list of transactions to void. 

2. Select the transaction to void and click OK. The Void dialog box with the transaction 
detail appears with a confirmation prompt. 

3. Click OK to void the transaction, or click Cancel to cancel the void.

Figure 2-13  Select Transaction Dialog Box

Figure 2-14  Void Dialog Box
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Authorizing a Check

Use the Check Authorize command for the Nova processor only and to authorize a check. 

To authorize a check:

1. Select Functions > Check Authorize. If you are using multiple processors, or have mul-
tiple processors configured, the Select Processor dialog box appears. 

2. Select Nova and click OK. The Check Authorization dialog box appears. 

3. Type either the drivers license number of the customer or the MICR numbers on the 
bottom of the check. Do not type both. 

4. Type the state, check number, zip code, and amount. 

Figure 2-15  Check Authorization Dialog Box
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5. Click OK. EDC initiates a phone call to the Nova processor and a message approving or 

declining the check appears. 

6. Click OK to complete the authorization.

Figure 2-16  Check Authorization Confirmation
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Performing Batch Functions
As the FOH accepts payments, the monies from credit card and gift card payments are not real-
ized until you settle a batch. A batch is a collection of transactions processed through Aloha EDC
that is sent to the respective hosts for finalization. Collecting of actual payments are outside of
the Aloha EDC program. 

A batch does not rely on the End-of-Day process. You can run a batch multiple times in one day,
or combine several days into one settlement. You must always verify batch totals before settling a
batch. In restaurants with split-settlement—that is, settlement is handled through more than one
processor—the system prompts for the processor to settle. 

When you settle a batch, you cannot perform any other functions until the settlement ends. The
system initiates the data connection with the processor, carries out the settlement procedures, and
finalizes the process by writing the transactions to a dated settlement file, with the format of
MMDDYYYY.stl in the \EDC\<processor name> directory. For example, if you use CES for
settlement, settlement files appear in the \EDC\CES directory. Aloha EDC starts a new batch file
to accept transactions. The *.stl files provide a history of all transactions settled through each
processor, and remain on the system until you manually delete them. The decision of when to
delete the files is left to restaurant management. 

Settling a Batch

Use the Settle Batch command to settle the current batch, which is usually part of a normal man-
agement routine each day. 

To settle a batch:

1. Select Functions > Settle Batch. If you are using multiple processors, or have multiple 
processors configured, the Select Processor dialog box appears. 

2. Select a processor from the list and click OK.
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To select a row of processors, hold down Shift and select the first and last processor. All 
processors in the range are selected. 

To select multiple processors that are not in a row, hold down Ctrl and select any num-
ber of processors. 

Figure 2-17  Select Multiple Processors in a Row

Figure 2-18  Select Multiple Processors not in a Row
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3. Click OK. The confirmation prompt appears. 

4. Click OK to settle the batch or click Cancel to cancel the settlement.

Forcing a Settlement

Use the Force Settlement command to force a settlement when a batch does not settle. In very
unusual circumstances, sometimes a batch will complete the settlement process, but the EDC
server does not receive the confirmation from the credit card processor. This can happen when
settlement is interrupted or when the processor manually settles a batch on their end to solve a
problem. When this occurs, the files are not archived, and the transactions could be charged to
the customer more than once. The Force Settlement command archives the current batch without
performing the normal settlement procedures. 

To force a settlement:

1. Select Functions > Force Settlement. If you are using multiple processors, or have mul-
tiple processors configured, the Select Processor dialog box appears.

2. Select the processor and click OK. The batch files are archived and the system is ready 
for new transactions. 

Figure 2-19  Confirm Batch Settle

Use Force Settlement only when a batch has already been confirmed and 
settled. The restaurant receives no revenue from a batch if the Force Set-
tlement function is used on a batch that has not yet been settled. Do not 
use this function unless you have received instructions from the techni-
cal support personnel to do so.
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Getting Current Batch Totals

Use the Get Current Batch Totals command for the Nova processor only. The command accesses
the current batch maintained on the Nova host processor and displays the totals on the dialog box.
If you cannot settle a batch, this is a useful function to compare the totals of the restaurant with
the totals of the processor and find the discrepancy. 

The Get Current Batch Totals is not available for processors using a secure socket layer connec-
tion (SSL). If you have a multi-processor environment, where you are using an SSL connection
for one processor, and a non-SSL connection for another processor, the Get Current Batch Totals
menu option is available; however, the Aloha system displays an error message if you attempt to
use the Get Current Batch Totals function for the processor using an SSL connection.

To get current batch totals:

1. Select Functions > Get Current Batch Totals. If you are using multiple processors, or 
have multiple processors configured, the Select Processor dialog box appears. 

2. Select Nova and click OK. EDC initiates a phone call to the Nova processor and the 
totals are brought forward and displayed. 

3. Click OK.

Getting Previous Batch Totals

Use the Get Previous Batch Totals command for the Nova processor only. The command accesses
the previous batch maintained on the Nova host processor and display the totals on the dialog
box. 

Figure 2-20  Current Batch Total
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To get previous batch totals:

1. Select Functions > Get Previous Batch Totals. If you are using multiple processors, or 
have multiple processors configured, the Select Processor dialog box appears. 

2. Select Nova and click OK. EDC initiates a phone call to the Nova processor and the 
totals are brought forward and displayed. 

3. Click OK.

Purging a Batch 

Use the Purge Batch command for the Nova processor only. When there is a discrepancy between
the current batch maintained on the Nova host processor and the current batch located on the
local computer, this command deletes the Nova batch so that the local batch can be settled. This
does not solve any discrepancies between the two. Check discrepancies manually before purging
the batch. 

To purge batch totals:

1. Select Functions > Purge Batch. If you are using multiple processors, or have multiple 
processors configured, the Select Processor dialog box appears. 

Figure 2-21  Previous Batch Total
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2. Select Nova and click OK. EDC initiates a phone call to the Nova processor and a mes-
sage letting you know the purge was successful displays. 

3. Click OK.

Editing a Rejected Transaction

Use the Edit Rejected Transactions command to edit transactions that have been rejected during a
batch settlement, if supported by the processor. If a transaction is rejected, it is written to an .rej
file. You can then recall the transaction to alter and then retry the settlement. Once the transaction
is edited, it is re-added to the current list of .txn files, and then processed during the next batch
settlement. The Edit Rejected Transactions menu option is only accessible if you select ‘Remove
Rejected Transactions’ on one or more of the processor specific dialog boxes that support the Edit
Rejected Transactions functionality. 

To edit a rejected transaction:

1. Select Edit Rejected Transactions to display a list of transactions on file. 

Figure 2-22  Batch Purge Confirmation

Refer to the supported processors section to determine if the processor supports editing 
rejected transactions. If you are using a processor that does not support Edit Rejected 
Transactions, this menu option is greyed out.
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2. Select the rejected transaction (.rej) to edit, and click OK. The Edit Rejected Transac-
tion dialog box with the transaction detail appears. 

3. Type the card number, expiration date, amount, tip, and authorization code. The 
Reject Count number indicates the number of rejected transactions on file.

4. After changing any necessary information, click Re-Add. The edited transaction is rein-
serted into the current batch. 

To remove a transaction from the batch, click Delete.

5. Click Cancel to exit.

Figure 2-23  Edit Rejected Transaction Dialog Box

When you click Re-Add or Delete, the POS status on the Aloha EDC main screen is 
momentarily changed to ‘POS is OFF’. Once the rejected transactions are reloaded into 
the current batch, the POS status returns to ‘POS is ON’.
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Reporting EDC
Use the Report menu to view and print EDC transactions, offline transactions, and export reports
to a common format. You can report information from the current batch, previous settlement
batches in the history files, or a combination of current and previous batches. 

Viewing and Printing the Batch Transaction Report

View and print the Batch Transaction report to monitor and keep track of transactions for current
and settled batches. You can include multiple batches, card types, and have up to two sorts. Per-
form this procedure before or after settling a batch.

Figure 2-24  Report Dropdown Menu

Refer to the feature focus guide pertaining to the gift card you use, for information on 
using the Offline Transaction Report.
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To view and print the Batch Transaction Report:

1. Select Reports > Review Transactions to display the Batch Transaction Report dialog 
box. 

2. Select the batch(s).

Batches — Displays batch files that exist on the system in date order with the current
batch for each processor at the top of the list, followed by the batch history files (*.stl).
You can generate a report from the batches listed here, using data from the current batch,
a particular date, a combination of the current batch and multiple dates, or all dates. 

3. Select the credit card type(s).

Card Types — Indicates the card type to include in the report. All card types are listed.

Figure 2-25  Batch Transaction Report Dialog Box

The date on the .stl file is the actual date settled, not the date of business. If a restaurant 
settles their credit cards after midnight, the settlement date will not match the date of 
business. Any batch history files (*stl) manually deleted from the system do not appear 
in the Batches box.
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4. Select the employee(s) to report. 

Employees — Displays employees in which to sort the report by. Select ‘All’ to include
all employees.

5. Select from the First Sort By inset to determine the first sort order.

First Sort By — Determines the order of the data on the report. In this case, the data is
sorted first by Employee, then by Card Number.

6. Select from the Second Sort By inset to determine the second sort order after ‘First Sort 
By’.

Second Sort By — Determines the order of the data on the report. In this case, the data is
sorted first by Employee, then by Card Number. 

7. Select the Multi-Store Mode.

Multi-Store Mode — Sorts and totals the report by store or by terminal. Used in loca-
tions that have several stores within the same site. In this case, the report sorts by the
selection made here first, then the selections made in ‘First Sort By’ and ‘Second Sort
By.’ 

You must configure your Terminal ID, Revenue Center, and Store in Maintenance > 
Hardware > Terminals for the report to sort by store.
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8. Click View to preview the report. 

Use the arrow keys to maneuver around within the report. The Magnifying icon located 
on the bottom of the dialog box is used to zoom in on a particular area of the report. To 
use this function, click the Magnifying icon and then click the area of the report to mag-
nify. To print the report after viewing it, click the Printer icon. 

9. Click Print to print the report, if desired.
10. Close the report.

Figure 2-26  EDC Transaction Report Preview

report title report page

move forward/backward 
in the report

exit print the 
report

current view 
magnification vertical scroll bar
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A legend appears at the bottom of the Transaction Report and only appears if the transaction
occurred.

• *  = Automatic authorization occured in standalone mode.
• F  = Forced Transaction
• C  = Contactless entered card number
• M = Manually entered card number
• ( ) = No Capture: The transaction in batch was not part of settlement. This does not refer 

to a voided transaction. Possible causes: Uncompleted PreAuth, or card type not enabled 
on this Merchant ID.

• O  = Offline transaction
• P  = Partial redemption
• V  = Voided gift card transcation

Exporting the Batch Transaction Report

The EDC reports in the Aloha system display the net results of all transactions per card type and
not the transaction history of adjustments, voids, declines, reversals, and other types of communi-
cation. This information has typically been retrieved from .txn and .stl files, however, the imple-
mentation of masking and encrypting card numbers compromises the ability to trace transactions
related to an account. The restaurant must be able to trace card activity for the following reasons:

• For instances when balances become out of sync between Aloha reports and the gift card 
host. 

• For discrepancies from customers about transactions. For example, the customer may 
inquire why there are multiple transactions when an employee applies their credit card to 
the wrong check, voids the transaction, and then applies the payment to the correct check. 

With the ability to create an EDC Batch Transaction report, the restaurant can provide a history of
card use, in the order that it occurred, for a date, or a range of dates, export the file into an appli-
cation, such as MSExcel©, and save the history to a disk, if necessary. The restaurant can then
compare the transaction history recorded at the store to the history at the processor or host.

The No Capture indication only happens with CES processors. It is not to be confused 
with voided transactions that are placed in parenthesis from processors that require 
voids to remain in the batch. Currently Nova and Maverick are the only supported pro-
cessors that will have these indications.
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Creating and Exporting the Batch Transaction Report

You must create the EDC Batch Transaction report from the Reports menu in EDC and export the
file to an application that supports a comma separated value (CSV) format. You select the
batches to include in the report, as well as the card types on which you want to report, and the
employees who performed the transactions.

To create and export the EDC transaction report:

1. Log in to Aloha EDC.
2. Select Reports > Create Transaction Report. Select the batch on which you want to 

report.

To select multiple batches in a row, hold down the Shift key, select the first batch and 
the last batch to include in the report. 

3. Select the card types to include in the report.
4. Select the employee who performed the transactions.

To select multiple employees in a row, hold down the Shift key, select the first 
employee and the last employee to include in the report.

To select multiple employees not in a row, hold down the Ctrl key, and select the 
employees to include in the report.

5. Click Export. The information writes to a .csv file and a confirmation message appears. 

Figure 2-27  
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6. Click OK.To view the EDC Batch Transaction report, double-click the .csv file to open 
MSExcel and display the transaction history. A portion of this report is shown in the fol-
lowing example: 

The column titles display on the first row. The card field appears as un-encrypted and 
adds spaces for every 4th digit to help with cell formatting. Blank fields are left blank and 
not filled with $0.00.

Changing the File Path of the Export File

You can change the file path of the export file by clicking the Export Settings button.

To change the file path of the export file:

1. From the Batch Transaction Export dialog box, click Export Settings to display the 
Export Settings dialog box. 

2. Type the file path and the name of the export file.
3. Click Save.

Type DOB Date Time Employee Table Check Auth 
Amt

Authorize 20040107 20040107 11:36:39 123 John Smith Table 12 10002 19.22

ADJUST 20040107 20040107 11:53:41 123 John Smith Table 12 10002 19.22

VOID 20040107 20040107 12:05:16 123 John Smith Table 12 10002

Figure 2-28  
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Automating the Batch Transaction Report

The Batch Transaction report details transaction information processed through EDC, such as
authorized amount, return codes, offline status, card balance before and after a transaction
occurred, and much more. You can electronically export the file to a comma separated value
(csv) format. You can now automate the creation of the file during the End-of-Day (EOD) pro-
cess 

To automate the EDC Batch Transaction export:

1. Open the Winhook batch file using Notepad.
2. Add an additional command, using the following parameters in the command line, to 

pass the information to EDC.exe. 

Parameter Description
/Date * Indicates the date of a dated subdirectory, or the current date if 

you are exporting today’s activity. You can also use /Date Latest 
to query file extensions, such as .stl, .A, and .B, and disregard the 
/BatchOffset parameter.
Example: /Date 20050505 or /Date Current or /Date Latest.

/ExportFile * Represents the full path and the name of the export file. You can 
point to a dated subdirectory using a variable. 
Example: /ExportFile <iberdir>/Exports/Transactions.csv

/ProcessorNumber * Represents the ID number of the processor. Refer to “Processor 
ID” on page 2-31.
Example: /ProcessorNumber 6. 

/Index Used if there are multiple instances of a processor, such as CES 
1 and CES 2. 
Example: /Index 2

/BatchOffset Used if there are multiple batches for the processor, for a given 
day. The parameter defaults to the current batch or the first settle-
ment file. 
Example: /BatchOffset 1

/Help Writes the command parameters with their corresponding 
description to Debout.edc. 
Example: /Help or /?

* Indicates a required parameter in the command line.
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When finished, your command line might look like the following: 
Date Current /ExportFile AlohaQS/Exports/Transactions.csv /ProcessorNumber 2 /
Index 2.

3. Select File > Save to save the Winhook batch file, and close Notepad. The export file 
generates during the next EOD.

The following chart lists the processors currently supported by the Aloha system and the proces-
sor ID number used for the parameter in the EDC Export file: 

Processor ID Currently Supported Processor Name
1 CES (First Data North)

2 Visanet 

3 American Express

4 BA Merchant Services

5 Global Payments

6 Nabanco (First Data South)

7 FDC

8 Nova

9 Maverick

10 FCCNet

11 Paymentech

12 DirectNet

13 $$$ in the Bank

14 Concord EFS (BuyPass)

15 AlohaNet (Universal Payment Interface)

16 BA Lynk

17 Fifth Third Bank

18 Stored Value Systems
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Support Information
If you cannot troubleshoot a problem with Aloha EDC, you must contact Radiant Systems for
technical support.

What do I need to send for Radiant Systems Technical Services or 
Development to research a problem?

• Dated subdirectory from a day that had problems.
• Settlement file for the same day, or a set of .txn files, if they cannot settle.
• Debout.edc.
• EDC.ini.
• DRWatson.log, if General Protection faults or other crashes have been occurring.
• A full description of the problem and when it started.

Make sure the dated subdirectory and the settlement file are for the same date of business. It is
common for support to receive mismatched files, because the date on the settlement file is often
the morning after the batch was built. So you might get dated subdirectory 19990715 and
19990715.stl, but quite often 19990715.stl is actually the batch from 19990714 that was settled
the next morning. This wastes a considerable amount of time. Look at the .stl with an editor if you
are not sure.
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Optimizing EDC
Making sure that EDC is authorizing as quickly as possible is important. If customers are waiting
30 seconds or longer for credit cards to authorize, that impacts their perception of the restaurant’s
service.

1. If the merchant is authorizing using 800 numbers, try using 950 numbers instead. It takes 
a long time to dial and connect to an 800 number. 950 numbers are special local numbers 
that connect extremely fast, usually on the first ring. Ask the credit card processor repre-
sentative for the number to use for a particular merchant. This can save several seconds 
per authorization.

2. Use Multi-trans. Multi-trans means that if you get two credit card authorization requests 
at the same time, you can authorize them during the same phone call. This saves a lot of 
time for the second authorization, because if you are already connected, an authorization 
only takes about 3 seconds. Multi-trans has the most impact in very busy operations that 
do a lot of credit card authorizations at the same time from different terminals. You can 
flag the Multi-trans flag in each processor specific dialog box. However, for some pro-
cessors the merchant must be authorized to use Multi-trans or it will not work. This is 
something that must be verified with the processor representative.

3. Make sure that your init string configures the modem to dial touch-tones as fast as possi-
ble. The default speed for touch-tones is usually pretty slow. You can usually save 1-2 
seconds by setting the touch-tone speed as fast as possible, typically 50ms.

4. Very slow authorization times may be a symptom that the system is getting errors and re-
dialing. Check the Debout.edc file for possible errors.

If you can get individual authorization times below 20 seconds, you are probably close to the
optimum speed. Getting times below 15 seconds is unusual. Merchants may claim that other sys-
tems can authorize significantly faster, but they are probably not using regular dial-up systems
(e.g. leased line or satellite), or the merchant may simply be mistaken. Aloha should be able to
authorize as fast as any other dial-up mechanism the merchant can demonstrate, at least within 2
seconds or so.
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Tips for Tracking Down EDC Problems
• Read the Debout.edc file. Read the Debout from the master terminal. Dump a transaction 

log and see what FOH transactions occurred. Search for the credit card number in the 
translog dump.

• Set DebugEDCSvr.exe=True in Aloha.ini. This outputs extra debugging information in 
Debout.edc, and can be invaluable for tracking down difficult problems. Be sure to turn 
this feature back off when the problem is resolved, because it will create very large 
Debout.edc files, which can slow authorization down and waste disk space.

• Check the magnetic card reader. Bad card reads can cause strange problems. Look in the 
.stl files and search for Track1 or Track2. You can usually spot bad card reads because 
they are much shorter than the others. The card reader may be dirty or defective.
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Settlement
Is it possible to “Unsettle” a batch?

Not usually. But, if the occasion arises, you can make Aloha EDC settle the same batch again.
For example, if a customer performs a Force Settlement and archives a batch without settling it
properly, you can bring back the batch and settle it. As previously described, the Settlement and
Force Settlement functions take all of the .txn files and merge them into an .stl file. The SplitStl
utility takes an .stl file and convert it back into txn files. If you use SplitStl to crack open a settle-
ment file, be aware that you usually need to delete the last .txn file that it creates. The reason for
this is that the last .txn file is typically the Settlement command that archived the batch, and the
batch will refuse to settle again unless you get rid of it. Of course, make sure you do not mix the
.txn files with another batch, and make sure that Aloha EDC restarts once you have the .txn files
in place.

What happens if settlement is interrupted?

If the Aloha EDC program ends unexpectedly during settlement, either because it crashed, or the
machine was turned off, the settling file is not deleted. When Aloha EDC starts, it checks to see if
there is a leftover settling file from the last time it ran. If there is, it refuses to do anything and
displays the following message: ‘Your last settlement was interrupted. You need to check
whether your batch made it through OK.’ Contact technical support to remove this message.

The only function available is the Batch Report. This is because Aloha EDC has no way of
knowing whether the current batch went through. Therefore, knowledgeable intervention is
required. The most important thing is to get the .txn files out of the processor’s directory before
you start the next day’s business. Ultimately, you must either delete the files or resettle them. You
do not want them mixed in with the next day’s sales if you have to delete them in the end.

The proper course of action is the following:

• Print a batch report for the current batch.
• Exit Aloha EDC entirely.
• Call the processor and find out when the last settlement came through and how much it 

was for.
• If the current batch did not go through, delete the settling file, restart Aloha EDC, and re-

settle the batch.
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• If the current batch did go through, delete the settling file, restart Aloha EDC, and per-
form the Force Settlement function, which archives the current batch without trying to re-
settle it.

• If the processor cannot tell you whether the batch went through, and you need to get the 
system up and running immediately, use File Manager, go to your processor’s directory 
and delete the file called Settling. Create a subdirectory call EDCMMDD. Highlight and 
move ALL of the .txn files into this newly created directory. After you do this, you 
should only have .stl files and perhaps a Settled file left in the processor’s directory.

• You can now restart EDC and it should not have any credit card transactions listed. You 
are now ready to proceed with the day’s business. Do not forget to turn POS ON from the 
Aloha EDC main screen, if it is not already.

• If you had to move .txn files to an EDCMMDD directory, you need to move them back 
into the correct processor directory once you know if the batch went through. You must 
ensure that no .txn files are in the current processor directory when you move the .txn 
files back in, so the best time to do this is normally after a settlement. After moving the 
.txn files back in, you must restart Aloha EDC, because Aloha EDC only reads in the .txn 
files at startup. If the processor said that the batch already went through, you would then 
use the Force Settlement function. If the processor said the batch did not go through, you 
should use the Settle Batch function to try and settle it again.

Be very careful when performing these actions. Be certain you understand why you are doing
what you are doing. A mistake can mean double-settling a batch, which results in unhappy cus-
tomers, or losing a batch, resulting in an unhappy restaurateur.

AMEX Settlement Failing with Error Message

You are probably dialing the wrong AMEX host for settlement. AMEX has several settlement
hosts around the country, and a merchant is assigned to a host. If you dial a host that does not rec-
ognize the merchant, it will respond, “You are not authorized to access this host,” and hang up.
The only problem is, they often hang up before they have finished sending the error message.
Aloha only receives the first few characters, followed by garbage. Also, if the customer is not set
up properly with AMEX to perform settlement, you could experience this problem. In either case,
double-check that the customer is authorized to settle directly with AMEX and verify the phone
number.
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Another cause of “You are not authorized” messages could be that AMEX has the merchant set
up for a different point-of-sale system, other than the Aloha system. If so, they reject settlement
attempts by the Aloha system. When we settle, we send a unique id, which identifies Aloha.
Unless AMEX is expecting the Aloha system to settle for a merchant, they reject our attempts to
settle. If a merchant is set up using the standard Aloha Account Request form for AMEX, this
should not happen. This is a rare problem because it only happens if the merchant had a previous
system that did direct settlement, and most of our competitors cannot. 
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Common Errors
This section covers LRC errors and errors when using specific processors.

LRC Errors

LRC errors are messages sent and received by EDC. If the LRC does not match the message,
some corruption of the message occurred. 

Corruption may be caused by several problems:

1. The phone line may be noisy. The phone company may need to check the line. EDC 
should be running on a direct line. Running through a phone system is asking for prob-
lems. Check that the power is clean. Be sure the phone line is not shared or being inter-
rupted.

2. If the modem is running on a cheap serial port, it may be dropping characters. Serial ports 
are how the computer sends and receives characters. The chip that handles the sending 
and receiving is called a UART, which stands for Universal Asynchronous Receiver/
Transmitter. Good serial ports have ‘buffered’ UARTs, which means that they can store 
several characters at a time. This greatly reduces the chance that the computer drops a 
character. UARTs in the 16000 range, (e.g. 16550) are generally good. UARTs in the 
8250 range are not buffered and are likely to cause problems if you use them for EDC or 
for Video. To investigate the serial port, access Ports in Control Panel. You must select 
the 'FIFO Enabled' option. FIFO is the ‘First In/First Out’ buffer on the UART. If it 
appears dimmed, there is not a buffer on your UART. This is not a common problem. If it 
does, you need to get a newer serial port. To confirm the UARTs your COM port has, use 
the utility UartType.com from our BBS or FTP site. To perform properly, the utility must 
be run in DOS mode. This means starting Windows 95/Windows NT in DOS mode. The 
symptoms of an incorrect UART are almost indistinguishable from a bad phone line. 
They include numerous retries and bad LRC errors in the Debout.EDC file. Although 
most new motherboards and serial cards have 16550 UART, some less expensive models 
may only have 16450 UARTs. It is best to check any new, untested brands before you use 
them. This UART problem is dangerous in that EDC may seem to perform properly with 
a few short tests, but when EDC is subjected to real business, the problem reveals itself.

3. Try using alternate phone numbers if they are available. Switch between local and long 
distance numbers, or vice-versa.

4. Experiment with the init string if it is an unfamiliar modem. Turning on error correction 
can help as long as it does not interfere with the connection itself.
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Common Errors Returned from Processors 
Processor Error Messages Resolution
AMEX INVL Response to 

INIT CTL
They have incorrect account information or are con-
necting at an incorrect baud rate.

AMEX Y Modem Error during 
transfer failed error -
618

Lost carrier during settlement (Phone line hung up 
before complete transmission of the settlement file.

CES Invalid Data Rec # When sending one of the packets it has found one with 
incorrect information. Need to turn debug on and find 
the last 2 transactions it sent. After locating and identi-
fying the 2 transactions, figure out why they are failing 
and correct the problem or void them.

CES Batch Full CES supports a maximum of 349 transactions per 
batch. In Aloha versions 5.2.5.104 and higher, you can 
add the ‘MaxTransactionsPerBatch’ variable to the CES 
section of EDC.ini and assign it a value that represents 
the expected maximum number of transactions. CES 
does not recommend changing this value, since it 
increases the opportunities for errors during settlement. 

FDC Error Unresolved out 
of balance batch, con-
tact First Data to 
clear.

This is from FDC and it means that the previous settle-
ment did not total completely, perhaps the phone 
dropped the connection before the settlement finished. 
You will have to call their help desk at 800-647-3722 to 
clear this message. Then you can re-settle.

NPC Error 66 Message sent from NPC meaning Duplicate Batch.

VISANET/
NPC

No batch response 
received.

Need to try again later. Possibly too much load on the 
processors network for it to keep up, processor network 
is temporarily out of service. Try again later.

VISANET Rejected batch - 
Parameter record on 
field x error E.

Usually caused by the Merchant Account information 
not being correct. Verify account information, including: 
Bank ID number (BIN), Merchant ID number. Verify that 
Visanet has not terminated your account. Verify that 
your account is enabled for Multi-Trans before enabling 
the Multi-Trans feature.
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VISANET Rejected batch - 
Detail record nn field y 
error E

Often caused by an invalid forced transaction in the 
batch. Also, verify that the merchant is entitled to settle 
AMEX and Discover transactions if you are trying to 
settle them. Void the transaction that is numbered nn. 
Write down all the information so that you can retry the 
transaction later, and void the transaction to remove it 
from the batch and try to settle again. If successful, 
note any differences between the failed transaction and 
the successful transaction.

VISANET ‘’’’Unexpected Bel’’’’ 
or ‘’’’Unexpected 
Ack’’’’ error when try-
ing to settle.

Like LRC errors, this error is usually indicative of a bad 
connection with the processor. When Aloha sends a 
batch to Visanet, it verifies each block sent by alternat-
ing between a ‘’’’bel’’’’or an ‘’’’ack’’’’ response. If Aloha 
receives two ‘’’’bels’’’’ in a row or two ‘’’’acks’’’’, then a 
block of data was lost. you can immediately attempt to 
settle the batch and it will typically settle. If the problem 
persists, try again later.

VISANET Duplicate batch #xxx 
on MMDD

If you look at the setup properties of Visanet, you will 
notice a batch number in the lower left hand corner. 
Each batch is assigned a number, and this number will 
increment with each batch. If Radiant Systems, or a 
dealer has to settle a batch at our office, the batch num-
ber will increment in the office but not at the store. 
Unless the store manually increments the number by 
one, they will receive this message.

VISANET Error 51 Declined When authorizing a credit card, a message is returned 
with error ‘51 Declined’. This response has been 
returned by Visa and means ‘Insufficient Funds’ or 
‘Insufficient Credit Limit’.

Processor Error Messages Resolution
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Nova Specifics

Nova is different than the other processors supported by Aloha EDC because it is what is known
as a hybrid processor. What this means for most Aloha dealers is that you can no longer do some
of the things you may be used to doing to support your customers when they encounter problems
at their restaurant. Some of the things Aloha dealers and technical support can no longer do with
Nova include: deleting .txn files to settle a batch, and moving a batch aside to be dealt with later
just so you can get the restaurant going again during a busy period. Due to these differences, we
have had an unusual number of problems with Nova, most stemming from confusion about how
Nova should work. Host-based (or in this case, hybrid) processors store all information on the
host’s (processor) side. Any update to credit card transactions (void, adjustment, authorization, or
refund) is updated on the host’s side as well as on your local Aloha file server. When you perform
your settlement with a host-based processor, all credit card transactions on the Aloha file server
must match up with the transactions stored on the host. If they do not, you will not be able to set-
tle and you must use one of the three new tools provided by Aloha to rectify the problem. For this
reason, editing a .txn file or deleting any .txn files will cause a mismatch with the information
held by the host.

In the Functions menu in the Aloha EDC program, there are three options at the bottom of the
list: Get Current Batch Totals, Get Previous Batch Totals, and Purge Batch. These are only used
when troubleshooting a problem with a host-based processor. They are not used with a terminal-
based processor.

Get Current Batch Totals — Calls the host and returns an on-screen dialogue showing the cur-
rent batch totals as held by the processor. If you cannot settle a batch, this is a useful function for
you to compare your total with theirs and find the discrepancy.

Get Previous Batch Totals — Calls the host and returns an on-screen dialog showing the previ-
ous batch totals. With this function, you can confirm that there was not an accidental settlement
causing a discrepancy between you and the host.
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Purge Batch — Purges the current batch from the host. Since this will not help you diagnose the
problem of not settling, it can be used as a last effort in synchronizing the information on your
computer with the host computer. This function purges the current batch’s information on the
host’s side and automatically rebuilds it the next time you attempt a settlement using Settle Batch.
You can then settle the batch, but keep in mind that the automatic rebuild process re-synchronizes
the host totals with the information currently in your local EDC terminal. This does not guarantee
that transaction information will not be lost or incorrect, and it would be wise to contact the pro-
cessor first and manually check all the transactions for discrepancies. However, it is extremely
rare that a batch purge is necessary, and in most cases the batch rebuilds correctly. 

Nova requires three sets of account numbers to be obtained from Nova before it will function.
The first is the Bank Identification Number (BIN) which is always a six-digit number. The second
is the Terminal ID number, which can be from one to 16 digits. And the third is the Merchant (or
vendor) ID number that can range from 1 to 16 digits. Obtain these numbers from Nova at
(800)725-1243 (touch-tone option 6 on Nova’s automated phone system). There have been a few
rare cases reported where a dealer or restaurant operator has called Nova and had them purge a
batch or do manual settlement on their end, and then deleted the batch on the restaurant machine.
This results in a decline on all authorizations afterward. The Debout.EDC file indicates an out of
sequence error. To correct this problem, manually edit the EDC.ini file located in the EDC direc-
tory. Locate the Nova section of this file, and reset the LastRecordNumber to zero, or call Aloha
Technical Services for further assistance.

A frequent problem is that a technician calls Nova with a problem settling, and Nova 
will go ahead and settle the batch on their end. If this occurs, Purge Batch will fail! 
Since the host has cleared away the batch, the correct course of action in Aloha EDC is 
to Force Settlement, which archives the current batch and skips the settlement process 
itself.
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Duplicate Transactions for the Same Credit Card Number

Remember that the FOH performs authorizations by creating an .req file and waiting for an .ans
file. In particular, the master terminal is the one that does this. If the master terminal goes down
while waiting for an .ans file, then a duplicate transaction, or a failed transaction, become possi-
ble. This is because the new master does not know whether the first .req transaction went
through, so it creates another .req file. This second request file may result in a duplicate transac-
tion in the batch, or the transaction may be rejected because it is recognized by the processor as a
duplicate. You can confirm this is what happened by looking in the .stl for the duplicate credit
card number. Write down the time of the authorization. Then dump the transaction log and look
around that time frame to see if the master terminal went down. This is an extremely rare occur-
rence. If the merchant prints or views a batch report before settling a batch, it should never be a
problem, because the batch report very explicitly warns the merchant if there are duplicate trans-
actions in the batch for the same credit card number.
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